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ABSTRACT
The research began with a review of recent natural disasters in the U.S. that showed there
was an average of 121 federally declared disasters per year. Ports are critical to every country
because they allow for the transport of commodities through that country and even
internationally. If a natural disaster were to strike a port that was not properly prepared, the port
would not only suffer, but the commodities that transported through there would be affected as
well. The major motivation for this thesis was to address the risk of coastal disasters posed to
people and critical infrastructure for port cities. The primary objective is to use remote sensing
data and geospatial analysis to simulate coastal disasters for mapping risks to communities and
infrastructure assets. The research included computer simulations of 2 m sea level rise (SLR) and
2 m tsunami wave surge using the Center for Advanced Infrastructure Technology (CAIT)
methodologies, as well as an extreme rainfall simulation. Case studies involved geospatial
mapping of infrastructure planimetrics of selected areas. The planimetric method using the
Landsat-8 multispectral satellite imagery, the L-BANS surface classification, and the 2011
National Land Cover Database (NLCD) were implemented to determine an efficient method for
identifying and mapping the built infrastructure, land use features and non-built areas. The study
sites included the greater metropolitan area of Los Angeles, the Port of Miami and surrounding
areas, and the Port of Gwadar and surrounding areas. The result showed that spatial mapping
using L-BANS is more efficient than the manual creation of planimetrics using geospatial
ii

analysis for mapping and identifying the critical infrastructure of coastal cities and ports.
However, by the NLCD (2011) for Los Angeles which was available through the United States
Geological Survey (USGS), it was determined to be more efficient and faster to generate the land
use and land cover features. Spatial maps of digital elevation models (DEM) for the three study
sites were obtained to create elevation maps that were used for performing the two simulations
methods of 2 m SLR, and 2 m tsunamis wave peak height (WPH). An analysis of variance
(ANOVA) was conducted to determine if three periods (1900 – 1970, 1971 – 2000, 2001 -2015)
seen in record occurrences of natural disasters were statistically significant. The ANOVA found
that the three periods were statistically significantly different and a rate of change analysis was
performed. The investigation found that the period of 2001 to 2015 had a 45.8% rate of decrease
from the previous period of 1971 to 2000. The ANOVA was also performed to determine if
there were any statistically significant difference between the means of the two simulation
methods and the means from the three study sites. The results showed that statistically
significant differences exist among the study sites and there is no statistically significant
difference between the two simulation methods. Further simulations, for the Los Angeles
metropolitan area, included extreme rainfall flood using the HEC-RAS software and 2005
hydrograph data from the area. A comparison between all simulation methods showed that the
extreme rainfall flood is more disastrous to people and infrastructures compared to 2 m SLR and
2 m tsunami WPH simulations. This evidence suggests, contrary to the National Oceanic and
Atmospheric Administration’s (NOAA) claim of climate-related 2 m SLR impacts, rainfall
flooding is more damaging to infrastructure and people’s lives. It can happen any year compared
to the SLR speculation of the year of 2100 or beyond.
iii

It is recommended to make disaster implementation plans for potential natural disasters
such as tsunamis, extreme rainfall floods, and climate-related rise in sea level.
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CHAPTER I
INTRODUCTION
1.1 Background and Motivation
Natural disasters pose great threats to infrastructure and communities. Figure 1 shows the
number of occurrences of natural disaster declarations for the past decade.
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Figure 1. Yearly disaster declarations for the United States, 2011 - 2016
According to Figure 1, there has been an average of 121 federally declared disasters a
year for the past decade. The figure also shows that in 2011. The figure indicates that in 2011,
there were over 240 federally declared disasters in the United States [1]. The year 2011 was also
equally disastrous for the entire world.
According to Munich Re, a global insurance firm, 2011 was the costliest year from
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damages and loss of life due to natural disasters. The recovery effort was estimated to cost over
$380 billion in United States dollars (USD). Other notable disasters that occurred during 2011
were the Japan earthquake and tsunami ($210 billion USD), the floods and landslides in Thailand
($40 billion USD), the New Zealand earthquake ($16 billion USD), and the April tornado
outbreak in the United States ($15 billion USD) [2].
Natural disasters are defined as a hazardous event where one of the four following events
occur [3].
1) There are 10 or more people killed;
2) Over 100 people are affected;
3) A request for international assistance;
4) A national state of emergency is declared.
Organizations such as the Red Cross, World Relief, and many others exist to help after a
disaster, and numerous organizations are working to equip people better to survive these
disasters. In the United States, the Federal Emergency Management Agency (FEMA) is
primarily responsible for response, aid, and recovery, after a natural disaster is federally
declared. Once the preliminary disaster assessment is finished and shows that the are requires
federal assistance for recovery, the natural disaster can be federally declared [1].
With disasters becoming more damaging to infrastructures and communities, steps need
to be implemented to harden infrastructure and keep communities informed about different
disasters that could happen [2].
Simulations of natural disasters can educate the public works agencies of the public about
the risk that exist. Using Light Detection and Ranging (LiDAR) satellite imagery, disaster
assessment processes can be expiated [4]. According to Uddin, “The availability of cost-
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competitive, high-resolution, multispectral satellite imagery provides tremendous opportunities
for analyzing infrastructure inventory, land use/land cover and traffic volumes” [4]. With remote
sensing and spatial technologies such as the National Land Cover Database (NLCD) or Landsat
imagery, information can be ascertain about a given area. This information could include
elevation or critical infrastructure locations. With this information, communities can determine
at-risk areas for individual disasters. Such disasters include; landslides, earthquakes, sea level
rise (SLR), extreme rainfall flooding. Later in this chapter, an overview of different spaceborne
and remote sensing technologies will be discussed.
The major motivation for this thesis was the need to assess the risk of coastal disasters to
people and critical infrastructures for port cities.

1.2

Objectives and Scope

The primary objective of this thesis is to use remote sensing data to simulate coastal disasters for
mapping risks for communities and infrastructure assets.
The scope of this research is limited Los Angeles, California: Miami, Florida: and
Gwadar, Pakistan. These three areas are essential to commerce hubs for their respective
countries. Each area has the potential to be affected by SLR due to climate impacts, tsunamis, or
extreme rainfall flooding.

1.3

Research Methodology

The following research methodology was used to accomplish the objectives.
1) Review natural disasters and their effects on communities and infrastructure.
2) Collect remote sensing data sources of satellite imagery, digital elevation model, and the
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2011 NLCD.
3) Create spatial maps of infrastructure and land use planimetrics using Landsat-8 satellite
imagery scenes and the 2011 NLCD for selected sites.
4) Perform the Center of Advanced Infrastructure Technology (CAIT) methodologies for 2
m SLR and 2 m tsunami wave peak height (WPH).
5) Perform computer simulation for selected site of Los Angeles for extreme rainfall flood.
6) Analyze the statistical significance of topography variability and simulation methods on
coastal hazards.
Spatial mapping was performed over the study areas using manual planimetrics, the
Center for Advanced Infrastructure and Technology (CAIT) Landsat Built-Up and Natural
Surfaces (LBANS) methodology, and the NLCD (2011). The strengths and weaknesses are
discussed later in this thesis.
This thesis then evaluates the different simulation methods and the selected study areas.
Analysis of Variance (ANOVA) was performed to compare the statistical significance of the
simulation methods and the selected study sites.

1.4

Review of Remote Sensing Data
Remote sensing has a variety of applications, which include terrain mapping,

developmental planning, and risk modeling. However, there is a different type of remote sensing
data that is better for various applications. Table 1 shows a selection of remote sensing data that
is available through the United States Geological Survey (USGS) [5].
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Table 1. Comparison of high resolution spaceborne and airborne remote sensing technologies

Landsat 8
SRTM 1 Arc
Second Global
Sentinel - 2
Landsat 7
IKONOS **
QuickBird 2
SASTER
Orbview 4
SPOT 5

Spatial
Resolution
(meters)
15
30

1 band

10 - 60
15
1
0.62
VNIR: 15
IR: 30-90
1
2.5 (20 for
Mid IR)

13 band
7 bands
4 bands
4 bands

Temporal
Resolution
(days)
16
Space Shuttle
Endeavor
10
16
3.5-5
1.5-7

14 bands

In Space Shuttle

Variable

4 bands

3

8x8

4 bands

1-4

60 x 60

Spectral
Resolution
11 band

Footprint
(km x km)
170 x 183
225 km Swath
at 233 km
Variable
185 x 185
11 x 11
16.5 x 16.5

5-10 Swath at
Airborne IfSAR
1-2
X bands
On Demand
5,000 - 10,000
m height
9 x 9 at 3,000
Aerial Photo
Up to 0.15
Visible band
On Demand
m
Airborne LiDAR
Up to 0.15
NIR band
On Demand
Very Dense
IR = infrared, NIR = Near Infrared, VNIR = Very Near Infrared, IfSAR =
Interferometric Synthetic Aperture Radar
* LiDAR measurement at 500 meters above terrain level: about 5-10 points per 1 m2 on
the ground
** Decommissioned due to accuracy irregularity

Table 1 shows some of the high resolution spaceborne and airborne remote sensing
technologies. Durmas, in his M.S. thesis, compiled a list of over 20 of these technologies and
reviewed each one [6]. However, since the publication of Durmas’s thesis, there have been a
few breakthroughs in the technologies. With these breakthrough in mind, a simplified list was
formed. The top three technologies shown in Table 1 are the most accurate and newest remote
sensing technologies that are available to the public. These are some of the more widely used
remote sensing technologies that are available. The three technologies are the Landsat-8
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mission, the Shuttle Radar Topography Mission (SRTM) 1 Arc Second-Global mission, and the
Sentinel-2 missions.
In 2013 Landsat-8 was launched as a collaboration between the USGS and the National
Aeronautics Space Agency (NASA). NASA describes the imagery as the future of Landsat
satellite imagery. The valuable data and imagery that the satellites collect are useful to the
agriculture, education, business, and science and government sectors of any and every economy
[7]. The program has allowed unprecedented changes in how land use and land cover are
classified as they are affected by the weather, climate impact, ecosystem diversity, and services
of the area. The difference between Landsat-8 and Landsat-7 is two new features that allow for
the collection of thermal reflectance and coastal areas. The Landsat-8 satellite completes a
rotation around the earth every 99 minutes and has a temporal resolution of 14 days. Landsat-8
has a spectral resolution of 15 meters [7].
The European Commission Copernicus programmed designed the Sentinel satellites to
deliver remote sensing data about Europe and the rest of the world. The creation of this satellite
fleet is due to a consortium of 60 companies to optimize image quality and improve data
recovery using optical communications. The mission consists of two satellites. Sentinel-2A
operates on a 10-day cycle and focuses only on Europe. Sentinel-2B was launched early 2017
and will focus on other land surfaces and large islands. These two satellites will operate in
conjunction and will have a temporal resolution of five days. The Sentinel-2 mission acquires 13
spectral bands in the visible, NIR, VNIR, and Shortwave Infrared. It shares all 11 bands with
Landsat-8 plus an additional two bands that will allow for cloud and atmospheric corrections.
The spectral resolution for the Sentinel-2 satellites is 10 to 60 meters [8].
The SRTM 1 Arc-Second Global is a global elevation dataset. Interferometric radar
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gathered elevation data, as a part of the Space Shuttle Endeavour mission in 2000. During the
11-day mission, the Endeavour orbited earth 16 times a day. This allowed for the collection of
over 80% of the earth’s land surface elevation. The collection method included two antennas at
opposite ends of the space shuttle that sent down two signals at the same time. The offset
variances between the two signals allowed for the calculation of a point elevations. The data
collected has a spectral resolution of 30 m x 30 m [9].
The other nine high resolution spaceborne and airborne remote sensing technologies,
have either been replaced with more accurate technologies or have been updated to include better
equipment.
One key advantage of using spaceborne multispectral satellite imagery is to have a
permanent record of the terrain that is clear. The spaceborne imagery is also georeferenced.
Applications such as LiDAR require the coordinates it to identify features and potential
obstacles. A limitation of the spaceborne satellite imagery is that it is constrained to nighttime,
and cloud cover. Applications of LiDAR are not.

1.5

Implementation of Research Products

Possible implementation of this thesis include:


Creation of infrastructure and land use spatial maps,



Risk mapping due to 2 m SLR and 2 m tsunami WPH,



First responder priority maps in the event of natural disasters, and



Assessing the effects of natural disasters to coastal cities and port infrastructure.
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CHAPTER II
GEOSPATIAL ASSESSMENT OF NATURAL DISASTERS
2.1 Review of Natural Disasters and Impacts on Coastal Areas
On January 21, 2017, a tornado touched down in Hattiesburg, MS, and left miles of
destruction. Not only did this tornado affect a large city, but it also demolished a large university
in Mississippi, displaced thousands of students and families, destroyed numerous commercial
buildings, critical infrastructure, and wrecked the livelihood and certainty of thousands of people
living in the area [10].
During the summer of 2016, the area near Baton Rouge, LA, experienced a recordbreaking flood. From August 8th to the 14th, over 6.9 trillion gallons of water fell across the state
of Louisiana. The Federal Emergency Management Organization (FEMA) has provided over
$11 million dollars through the National Flood Insurance Program (NFIP), while over $55
million was approved by the US government to assist those affected [11].
On March 11, 2011, a 9.1 magnitude earthquake occurred over 250 miles away from
Tokyo, Japan. This powerful earthquake not only caused damage to the main island of Honshu,
Japan but also caused several large tsunamis. These tsunamis then triggered a major nuclear
reactor meltdown that took weeks to solve and was eventually classified as a level 7 nuclear
emergency by the World Nuclear Association (WNA), The category seven nuclear emergency is
the highest the WNA assigns. It is the same classification of Chernobyl [12].
From the three disasters mentioned above, hundreds of thousands, if not millions, of
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dollars would be spent to rebuild the areas back to the flourishing economies and communities.
After a disaster, change is unavoidable, and the road to recovery is difficult. Therefore, natural
disasters need to be studied to find out the causes, create an earlier warning system, and harden
infrastructure to withstand the effects of such a horrible catastrophe.
The disasters that occur today have been increasing in intensity and frequency, yet natural
disasters have always been catastrophic. Figure 2 shows a selection of major disasters from 1908
to 2000.

Figure 2. Major Disasters from 1908 to 2000
Figure 2 shows some of the top major disasters that have occurred in the past decade. The
different disaster types include earthquakes, fires, maritime disasters, and even weather related.
From the 24 disasters shown, over 6.9 million people have lost their lives. Countless more were
forced to evacuate the areas altogether. On top of that, Figure 2 only displays 29 major disasters
[13]. Over the past century, there have been more than 13,000 reported natural disasters. The
Intergovernmental Panel on Climate Change (IPCC) has stated that “major impacts of climate
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change the magnitude and frequency of extreme weather events” [14].
Period 2, 1971-2000
N = 45
Mean: 205
SD: 111
COV: 54.2%
Period 1, 1900-1970
Period 3, 2001-2015

N = 71

N = 15

Mean: 20

Mean: 411

SD: 21

SD: 52

COV: 102.1%

COV: 12.7%

Figure 3. Worldwide disaster occurrences, 1900 – 2015
2.1.1 Sample Design for Natural Disaster Occurrences
Figure 3 displays worldwide occurrences of natural disasters from the years of 1900 to
2015. The 116 years, represented, have a mean of 119 natural disasters per year [13]. Analysis
of variance (ANOVA) was performed to determine if there was any statistically significant
difference between different periods. Three periods were selected based on the trend line
behavior. In the first period, there is a gentle slope, the second period has a steeper slope, while
the third has a negative slope that shows a decline in the number of disasters. Table 2 shows the
number of data points, the mean, the standard deviation, and the coefficient of variation of the
occurrences of natural disasters. There are 116 grand total natural disaster occurrence years.
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Table 2. Level of factor (year periods)
Factor 1

Period 1
(1900 - 1970)

Period 2
(1971 - 2000)

Period 3
(2001 - 2015)

Total

Total Samples

71

45

15

116

Mean

20

205

411

119

Standard
Deviation

21

111

52

151

102.1%

54.2%

12.7%

127.3

Coefficient of
Variation

The objective of the one-way ANOVA was to determine if the occurrences of natural
disasters have statistically significant difference from the three different periods of time. The
analysis is a univariate analysis because only one response variable was analyzed.
2.1.2 Univariate One-Way ANOVA Model
Equation 1 shows the one-way ANOVA model that considers the single Factor of natural
disaster periods.
yi=µm+αi+ei
where,
y i = occurrence of natural disasters (dependent variable)
i = level of periods factor (i = 1: Period 1 (1900 -1970), i = 2: Period 2 (1971 – 2000),
i = 3: Period 3 (2001 - 2015))
µm = grand mean (for all year periods)
α i = effect of yearly periods (i =1, 2, 3)
e i = error, randomly normal distribution where the mean is equal to zero

11

(1)

2.1.4 Hypothesis Testing for One-Way ANOVA for Yearly Periods (Factor)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of the occurrences of natural disasters from
1900 to 1970 (period 1), the mean of the occurrences of natural disasters from 1971 to
2000 (period 2), and the mean of the occurrences of natural disasters from 2001 to 2015
(period 3) are equal.
H0: µ1 = µ2 = µ3,
where,
µ1 = mean of the occurrences of natural disasters from 1900 to 1970
µ2 = mean of the occurrences of natural disasters from 1971 to 2000
µ3 = mean of the occurrences of natural disasters from 2001 to 2015
Alternative Hypothesis, H1: In the population, the mean of the occurrences of natural disasters
from 1900 to 1970 (period 1), the mean of the occurrences of natural disasters from 1971
to 2000 (period 2), and the mean of the occurrences of natural disasters from 2001 to
2015 (period 3) are different.
H1: µ1 ≠ µ2 ≠ µ3.
Step 2: Select Level of statistical significance, α
An α of 0.05 for the probability of type one error was chosen as the level of
significance for the one-way ANOVA because, within any of the yearly periods, α/2
(0.025) represents each side of the probability associated with rejecting the null hypothesis
when it is true. Figure 4 shows the F distribution sketch with α/2 = 0.025.
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Figure 4. The F distribution showing type 1 error
The ANOVA calculates F test criteria, the level of significance (p) and then uses a
decision rule criteria for hypothesis testing. The ANOVA is performed by comparing the
independent ratio level variables through what is known as an F-test. By comparison of
F critical and

F test, the null hypothesis can be rejected or accepted. F

critical is

found

through a distribution of the F table for a given α value and degree of freedom, while the
calculation of the F test statistic is calculated through a statistical package such as the
Statistical Package for the Social Sciences (SPSS) software [16].
The H0 is rejected if either the F test exceeds F critical (F test > F critical) or the SPSS result of
significance or probability (p) is less than the selected α/2 of 0.025 or [(p) < selected α/2]. The
hypothesis testing that was used was the comparison of the significance or probability (p) and the
selected α/2 of 0.025.
Decision Rule: Reject the H0 if the result of the calculated α/2 is less than or equal to the selected
α/2 of 0.025 (calculated α/2 ≤ 0.025).
Step 4: Compute the Level of Significance (p)
Through the use of SPSS, the One-Way ANOVA was performed. The dependent
variable was the occurrence of natural disasters, and the factor was the period. No other options
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were selected, and the ANOVA was conducted. Table 3 shows the results from the SPSS output
for the one-way ANOVA.
Table 3. One-way ANOVA test results from SPSS
Occurrences of Natural Disasters
Sum of Squares

df

Mean Square

F

Sig.

Between Groups

2,195,359.903

2

1,097,679.952

291.267

.000

Within Groups

425,855.855

113

3,768.636

Total

2,621,215.759

115

Step 5: Interpret the results for the natural disaster occurrence periods (SPSS results show F test
and probability α value)
Table 3 shows that the significance or probability value is 0.000. According to the
decision rule, p (0.000) < α/2 (0.025), the H0 was rejected. These results imply that there is a
statistically significant difference between the mean number of the occurrences of natural
disaster for the three time periods.
2.1.4 Rate of Change Analysis for Occurrences of Natural Disasters
The ANOVA showed that there was statistically significant difference between the three
time periods. The goal of the analysis was to determine the trend within the three periods. Table
4 shows the results of the analysis.
Table 4. Rate of change in natural disaster occurrences
Total Percent

Percent per Year

Period 1

106

1.5

Period 2

1,031

22.9

Period 3

-687

-45.8

14

The rate of change represents the linear trend line within the periods. As mentioned
above, the occurrences between 1900 and 2015 were split into three groups. As shown in Figure
3, there is an almost linear increase in the number of occurrences in period 1 (1900 to 1970),
with an increase of 1.5% per year in the number of natural disasters. Period 2 (1971 to 2000)
showed 15 times more occurrences of natural disasters than period 1. There was an increase of
22.9% per year in the number of natural disasters during period 2. There was almost three times
reduction in the number of occurrences per year in period 3 (2001 to 2015) compared to period 2.
Period 3 had a decrease of 45.8% per year in the number of natural disasters. These results
demonstrate that the number of natural disasters per year has reduced since 2001. The results do
not support the IPCC's claim that global warming accelerates the number of weather-related
disasters.
2.1.5 People Displaced by Natural Disasters
The ANOVA and the rate of change analysis show that the occurrence of natural disasters
is decreasing. However, natural disasters will never cease due to the nature of how the earth is.
The natural disasters that occur in the future will still affect countless people and disrupt
families, communities, and commerce.
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Top 3 Displacements (people)
1. Philippines: 7,227,669
Total Countries Represented: 259

2. Japan: 6,386,303
3. China: 5,924,143

Figure 5. Spatial map of people displaced by natural disasters in 2013
Figure 5 displays that amount of people displaced by different types of natural disasters
in 2013. In 2013 there were over 28 million people displaced by natural disasters. The disasters
represented do not include long-term disasters such as drought or mechanical failures. The
Internal Displacement Monitoring Centre (IDMC) monitors displacement of people due to
famine, war, or natural hazards. The IDMC defines a displaced person as someone who is forced
to flee their home but remains in the same country. The IDMC estimates that since 2005, the
amount of internally displaced people on average is 26.4 million people. The rate of internally
displace people is the same as one person per second [17].
With over 26.4 million people displaced annually, hardening of infrastructure needs to
take place in disaster prone areas to better protect the people that live in that area. While it may
not be possible to enforce and update every building in a city to a new building code, new
construction should ensure that the existing infrastructure will be able to withstand natural
disasters prominent in that area. Also, the residents in that area should know the necessary
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procedures for protection, such as an evacuation route during a hurricane. The following
sections explain several types of natural disasters.

2.2

Assessment of Natural Disaster Risk on Infrastructure and Communities
Natural disasters prove a substantial risk to infrastructure and communities. Earthquakes

can destroy entire cities, floods can displace communities, tornadoes can create paths of
destruction, and the list goes on and on. Knowing that these natural disasters can take place at
any time and place, the protection of people, and infrastructure needs to be a priority. Figure 6
shows a spatial map of worldwide megacities for 2015.

Figure 6. Spatial map of worldwide megacities for 2015
Megacities are defined as a city that has a population of 10 million or more [18]. As of
2015, there were 29 megacities containing over 470 million people. China has the most, with six
megacities, compared to the United States with two.
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Figure 7. Worldwide megacities projected for 2030
Figure 7 shows the projection megacities for 2030. The number of megacities is
expected to grow by four by 2030. The total population within these cities is estimated to be
over 600 million people. With the vast number of megacities growing, the infrastructure of those
cities needs to be hardened to better protect the population better [18].
“Every year since 1979, the World Economic Forum conducts the Executive Opinion
Survey (EOS). This survey captures invaluable information on a broad range of socio-economic
issues. In the 2014 edition, over 13,000 executives in 144 economies were surveyed” [19]. S &
P and Fortune 500 companies are presented this survey. In the 2014 edition of the EOS,
respondents were asked to select the five global risks that they were most concerned with for
doing business in their country. The five global risks were ranked from 1 (Highest concern) to 5
(Lowest concern). The global risks include topics about the stability of the region, economic
issues, environmental concerns, and interstate conflicts. Table 5 shows a list of the global risk
topics presented in the EOS” [19].
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Table 5. Executive Opinion Survey of 2014 global risks [19]
Breakdown of

Prolonged neglect

Escalation of

Violent

Greater incidence

critical information

of critical

economic and

interstate

of

infrastructure and

infrastructure and

resources

conflict with

environmentally

networks

its development

nationalization

regional

related events

needs

consequences

Failure of climate-

Oil price shock to

Failure of a

Profound

Major escalation

change mitigation

the global

major financial

political and

in organized

and adaptation

economy

mechanism or

social

crime and illicit

institution

instability

trade

Escalation in large-

Massive incident

Mismanaged

Large-scale

Pandemic

scale cyber attacks

of data fraud/theft

urbanization

terrorist

outbreak

attacks
Fiscal crises in key

Water crises

Liquidity

economies

Food crises

crises

Natural disasters are related to ten of the 19 issues discussed. They covered climate
impacts, food and water shortages, and diseases. Four pertained to infrastructure related
problems, such as breakdown due to age or mismanagement. The other five were related to the
political stability of other nations and other conflicts. Clearly, one of the top concerns was about
natural disaster events. The following sections discuss different types of natural disasters.

2.3

Geological Hazards
Geological hazards occur every day. They can create beautiful landscapes, or bring

devastation to those in the way. Some take time, and others are instantaneous. One of the most
time intensive geological hazards is erosion due to wind or water [20]. Erosion through water
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that has created countless national parks like Zion, Yosemite, or the Grand Canyon, while wind
developed other features such as Arches or Monument Valley in Arizona. Figure 8 shows the
effects of erosion in Zion National Park.

Figure 8. Narrows at Zion National Park
The creation of the Narrows is due to the Virgin River eroding the limestone base of the
canyon. The Narrows is a canyon that ranges in size. It can be as wide as 50 feet to as narrow as
10 feet. The depth of the canyon is anywhere between 200 feet to 450 feet. The Virgin River
has been measured to flow anywhere between 50 to 80 cubic feet per second. Due to the current
of the river, the steep-walled canyon was formed [21]. Other hazards caused by erosion are
discussed in a later section.
While some natural hazards create scenic canyons, others can be quite deadly and

20

damaging to infrastructure. Some potentially hazardous geological hazards are landslides,
volcanic eruptions, earthquakes, and tsunamis. One such example was the 1906 San Francisco
7.8 magnitude earthquake. However, the earthquake only lasted a minute. The reason this
earthquake was so deadly was what happened after the earthquake. When the earthquake struck
San Francisco, an enormous blaze broke out. Due to a lack of response, it was not contained and
eventually died out due to the weather. Figure 9 shows some of the destruction caused by this
earthquake and resulting events.

Figure 9. San Francisco downtown commercial district after the 1906 earthquake.
Figure 9 shows the damage to the downtown commercial district after the earthquake and
resulting fire. The damage from the resulting fire, shows that geological hazards are extremely
detrimental to infrastructure and people when combined with other hazards. Although the
technology and building regulations were completely different a century ago, better organization
and resource management could have prevented this disaster [22].
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2.3.1 Landslides
Landslides are sudden shifts in the earth that cause the surface of the land to shift and
move suddenly. Erosion, heavy rains, earthquake-caused stresses on weak slopes, volcanic
eruptions, or excess weight on an edge are causes of landslides. The slope material that breaks
away during a landslide develops enough force to pick up trees, houses, and cars. The debris
flow can indirectly block rivers, tributaries, and bridges, causing flooding. The USGS estimates
that over $1 billion dollars (USD) in damages occur from landslides annually, and around 20 to
50 people die per year as a result in the United States alone [23].
Landslides are always under constant monitoring from the USGS Landslide Hazard
Program. The program conducts hazard assessments and technical assistance after a landslide
occurs, and pursues investigation and forecasting of landslides. By using high resolution, threedimensional elevation models in the form of light detection and ranging (LiDAR) data or
Interferometric Synthetic Aperture Radar (IfSAR), forecasting of landslides are possible. The
Landslide Hazard program uses this elevation data to create models to identify possible landslide
locations, to help develop evacuation routes, to create an inventory of deposits from landslides
and to develop approaches for estimating thickness and ages for the landslide materials. It has
been estimated that using the LIDAR and IfSAR data benefits around $20.2 million (USD) and
can be 3 to 200 times more effective than older traditional modeling techniques [24].
One of the leading causes of landslides is excessive rainfall. Excessive rain will cause
rivers and lakes to rise, thus eroding away the banks. El Niño and La Niña patterns are the
classification of the systems that cause excessive rainfall. El Niño occurs when water in the
ocean becomes especially warm. The warmer water evaporates more quickly and causes wetter
conditions over portions around the Gulf of Mexico and the Atlantic Ocean but drier conditions
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around the Pacific coast. However, when La Niña occurs, the opposite is true. It will be wetter
than usual on the Pacific coast and drier on the Atlantic Coast [25]. Figure 10 shows the pattern
effects of the El Niño and La Niña cycles [25].

Figure 10. El Niño and La Niña effects
The 2017 flooding and landslides around Oroville, California is an example of how the El
Niño and La Niña cycles can affect different parts of the country. In February of 2017, this
region experienced one of the most devastating rain events in the past 20 years. Due to dry
conditions in the area, the water quickly saturated the ground and started eroding the soil
subsurface. The saturated ground caused land and mud slides to gain potential and in turn
weakened the dam structure [26].
Even though landslides are under constant surveillance, they still happen, and they are
still devastating. An example of this is the landslide that happened on April 10, 2013, outside of
Salt Lake City, Utah. This landslide had a movement of over 55 million ft3. That is enough
debris to cover New York’s Central Park with over 50 feet of debris. Fortunately, the mining
company that was working Brigham Canyon copper mine ceased operations, and there were no
casualties. Another notable landslide occurred in April 1983 in Thistle, Utah. The Thistle, Utah
landslide is the costliest landslide that has happened in the United States to date [27]. Figure 11
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shows an aerial view of Thistle, Utah, and the lake that formed after the landslide.

Figure 11. Thistle, Utah landslide
This image was taken approximately 2,000 feet above the Thistle landslide on a nearby
mountain. The image shows the massive movement and the sheer potential that landslides
possess. This landslide happened during an El Niño cycle. Due to the excessive rain caused by
the cycle, the landslide caused a massive lake to form. When the makeshift dam, caused by the
landslide, gave way, the 140-foot-deep lake flooded the nearby town. The estimated cost was
around $200 to
$400 million (1984 USD) in damage [27]. Adjusting for the inflation rate from 1984 to 2017, it
cost roughly between $600 million and $1 billion USD.
Landslides will always be a threat and will always be under surveillance. Due to the
rapid development of technology, monitoring landslides has become more advanced. The
advancement of technology is seen in the process the USGS monitor landslides. By using
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LIDAR and IfSAR imagery, it has been possible to identify possible landslide locations more
accurately. With these advancements, devastating landslides such as the Thistle or the Bingham
Canyon landslides will be avoidable in the future. Thus life, property, and infrastructure will be
protected through the preventative measures.
The two landslides that were previously mentioned were caused by to much cliff weight
that avalanched into the slide. While most landslides are caused by excess weight, there are still
others that have different causes, such as volcanos or earthquakes.
2.3.2 Volcanos
Molten rock and large amounts of gas exist deep within the earth’s crust. When molten
rock and gas deposits meet the earth, it is known as a volcano. Different volcanoes can be seen
everywhere. Some examples include Mount St. Helens, Krakatoa, and Mt. Fuji. When a
volcano is inactive for a short period, it is known as a dormant volcano. An example of a
dormant volcano is Crater Lake, shown in Figure 12.

Figure 12. Crater Lake in Oregon
While some volcanoes are dormant, there are still a wide number of active volcanos.
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Figure 13 shows some of the most active volcanos in the world.

Figure 13. Spatial map of worldwide active volcanos in 2015
The activeness of the volcanos was determined based their on activity during 2015 [28].
The most active region is in the Pacific Ocean near the Philippines and Japan. The region
extends over toward the west coast of South America. This region is commonly referred to as
the Ring of Fire. Over 75% of the active volcanoes are found within the Ring of Fire, and
around 90% of earthquakes occur in this region [29]. The Ring of Fire is the result of plate
tectonics. Plates are enormous chunks of the earth’s crust that are constantly moving. They can
collide, move apart, or slide next to each other. Figure 14 show a spatial map of the world’s
plate tectonic boundaries.
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Figure 14. Spatial map of the plate tectonic boundaries
The area around the Pacific Plate is primarily known as the Ring of Fire, but also the
Ring of Fire includes the Caroline Plate and the Philippine Sea plate. The action of the collisions
allows for the dense mantle material to become more buoyant and rise to the magma that will
eventually reach the earth’s surface. As the magma rises, it forces more dense material out of the
way and will eventually reach the top. The rising magma, cause plates to move, volcanoes to
erupt and the earth to shake [29].
2.3.3 Earthquakes
Earthquakes are a major geological hazard. Past major earthquakes are the 2010 Haiti
earthquake, the 1964 Alaska Earthquake, and the 2011 Japan earthquake. The movement of two
plates of the earth’s crust cause earthquakes. The movement of the plates can be a slip, collision,
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or subduction. The surface where they slide or slip is called a fault plane. These planes are
normally located at or near the plate tectonic boundaries [30]. The boundaries can be seen in
Figure 14.
The three earthquakes that were mentioned above all had a magnitude of over 9.0 on the
Richter scale. The Richter scale measures the seismic waves from the earthquake and then ranks
the resulting magnitude. Table 6 shows the frequency of different magnitude earthquakes per
year [31].
Table 6. Frequency of average amount of earthquakes per year
Magnitude

Earthquakes per year

8.5 to 8.9

0.3

8.0 to 8.4

1.1

7.5 to 7.9

3.1

7.0 to 7.4

15

6.5 to 6.9

56

6.0 to 6.4

210

Most earthquakes fall into these ranges. However, there are two groups not shown in
Table 6. Those are earthquakes with a magnitude of 9.0 or higher and earthquakes with a
magnitude of 5.9 and below. Earthquakes with magnitude of 9.0 or higher are rare. There have
only been six recorded since the invention of the seismograph in the 1880’s. The second group
of earthquakes have a magnitude of 5.9 and below. Earthquakes with these low magnitudes
under 2.5 are not felt but are recorded by seismographs. Earthquakes with magnitude of 2.5 to
5.9 do occur but cause little damage to infrastructure in the area [32].
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Because earthquakes happen when two plates slip past each other, it is near impossible to
predict where and when the next one will strike. However, earthquakes are known to occur on
fault lines.
2.3.4 Tsunamis
A tsunami is a series of ocean waves that send surges of water onto land. These waves
have the potential to be over 100 feet tall. These waves approach the shore up to 500 miles per
hour and gain momentum. With this momentum, tsunamis have the potential to cause
widespread destruction. Such destruction can be seen from the 2011 Japan tsunami that was
triggered by a 9.0 earthquake [33].

Figure 15. Container ship washed ashore after the 2011 Japan tsunami.
Figure 15 shows a container ship that was washed ashore during the tsunami. This ship
was found over 100 meters inland from the coast. This figure shows the power and the
magnitude that tsunamis can produce.
As mentioned, tsunamis, not only produce one wave but multiple waves. These waves
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each compound the amount of destruction caused by a tsunami. With each repeated wave
pattern, the infrastructure is at an increased risk of failure, thus putting people at risk. The
weakening of the infrastructure is due to the repeated blows caused by the waves. Tsunamis are
discussed more in detail in later chapters.

2.4

Extreme Weather and Climate Impacts
In addition to geological hazards, weather can create destruction as well. Storm systems

can create tornadoes and hurricanes. Drought conditions can affect forests and communities
through water shortages. Also, SLR due to climate impacts are predicted to occur over the next
century. The weather-related events mentioned above are discussed in the following sections.
2.4.1 Wildfires and Deforestation
Wildfires and deforestation are two disasters that can occur at the same time and can
complement each other. A wildfire is an uncontrolled fire that are fueled by the weather, wind,
or dry conditions. Deforestation is the mass clearing forests. When deforestation occurs, the
underbrush left behind can catch fire quickly and turn into an uncontrollable blaze.
On average, over 100,000 wildfires clear three to five million acres in the U.S. Wildfires
require three main conditions: fuel, oxygen, and a heat source. Fuel consists of any flammable
material, such as trees, brush, and even homes. The intensity of the fire become even greater
with a larger amount and diversity of fuel. The second condition for wildfires is oxygen. The
ambient air, drawn in allows for the combustion of the fuel source, which then creates wind and
updrafts that spread the fire further. The final requirement for a wildfire is a heat source. Heat
sources that can start a wildfire include human sources such as unextinguished campfires,
cigarette butts, or exhaust fumes from a vehicle. Other sources include dry, hot winds, heat from
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the sun, or even the exhaust fumes from a vehicle [35].
Wildfires are fought and monitored in the United States by the National Wildfire
Coordinating Group (NWCG). The NWCG has classified how wildfires are ranked. Table 7
shows the ranking system developed by the NWCG [35].

Table 7. Wildfire ranking system
Class

Description
Involves combustibles such as wood, cloth, paper, and plastics that require the

A

cooling effects of water, water solutions, or dry-chemical coatings to retard
combustion.
Involves inflammable liquids, gasses, greases, or substances where

B

extinguishment is most simplified by excluding air, preventing the release of
combustible vapors, thus suffocating the flame.

C

D

Involves electrical equipment whereby operator safety in procured through
use of electrically nonconductive extinguishing agents.
Involves combustible metals such as magnesium, titanium, and sodium which
require a non-reactive, heat absorbing medium for extinguishment.

The ranking system classifies different wildfires based on the type of material that the
wildfire consumes. Classification A contains fires fueled by organic materials, which is the
lowest ranking, while fires that include combustibles, such as metal, are classified as D, the
highest ranking. These wildfires can occur anywhere in the world, but they most commonly
occur in the western U.S. and can become worse due to the hot drought conditions that can be
seen in the area [35].
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As mentioned before, wildfires are complimented by deforestation. Forests cover over
30% of the land on earth. Every year, swaths of forest half the size of England are cut down, and
the leftover limbs, leaves and brush act can act as fuel for a fire when ignited.
The main cause of deforestation is the requirement of land for agriculture. Forests are
also cut down to make room for more urban development. Farmers cut forests to gain more
room for their livestock or crops, through a method called slash and burn. This technique often
leads to unsupervised fires. When these unsupervised fires grow, and remain unchecked, that
could result in wildfires [36]. Figure 16 shows how forest density has decreased over the past
few years.

Figure 16. Area covered by forests, 1990 – 2012
The bar graph displays that the amount of forest on Earth has been decreasing at an
average rate of 0.216% per year [37]. If this continues, there will be negative effects on the
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environment. Deforestation leads to the loss of habitat that millions of animals and plant species
thrive. It also drives climate change. The soil in forests is moist; without the cover provided by
the forests, the soil will dry out, and the water cycle will slow. The forest land eventually
becomes a desert. Another major impact of deforestation is the elimination of trees that play a
critical role in the balancing of absorption of harmful substances such as carbon dioxide and
other greenhouse gasses.
2.4.2 Tornadoes
During the spring of 2014, a severe storm system occurred throughout the South. This
system formed a total of 80 tornadoes. These tornados caused over $1 billion in damages and
killed 35 people. A tornado is a violently rotating column of air. Tornadoes are known to reach
wind speeds of over 300 miles per hour and extend over 50 miles. One can form when a warm
front meets a cold or dry front.
Tornadoes are measured based on the wind speed, and the amount of destruction. The
scales is called the Enhanced Fujita Tornado Damage Scale. The Enhanced Fujita scale looks at
three-second gust wind speed, and the amount of damage caused to determine the classification
of a tornado [38]. Table 8 displays the Enhanced Fujita Tornado Damage Scale.
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Table 8. Enhanced Fujita Tornado Damage Scale
Scale
Label

Estimated Three
Second Gust

Description of Damage

EF0

65-85 mph

EF1

86-110 mph

Moderate: Removes shingles and tiles from roofs, overturned mobile
homes, vehicle blown from road

EF2

111-135 mph

Considerable: vehicles lifted from stationary position, roofs removed
from frame-houses, light-object missiles created

EF3

136-165 mph

Severe: roofs removed from well-constructed homes, trains derailed,
heavy trees completely uprooted

EF4

166-200 mph

Devastating: Well-constructed homes leveled, vehicles thrown, large
object missiles created

EF5

>200 mph

Incredible: Strong-framed structures leveled, automobile-sized missiles
sent over 100 meters

Light: branches, small trees, and sign boards damaged

The most common tornados are EF2, EF3, and EF4. EF5 tornados are extremely rare,
and extremely dangerous [39]. Figure 17 shows the EF5 tornado that occurred in 2013 at Moore,
Oklahoma.

Figure 17. Moore, Oklahoma 2013 EF 5 tornado
The Moore, Oklahoma, tornado killed 24 people and caused over $2 billion (USD) in
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property damage. The tornado had a path over 17 miles long and was at least a mile wide [40].
2.4.3 Hurricanes
Another type of extreme weather natural disaster is a hurricane. Hurricanes are giant
spiraling tropical storms. These storms can sustain wind speeds over 160 miles per hour and
pour 2.4 trillion gallons of rain a day. These tropical storms can occur in both the Atlantic and
the Pacific Oceans.
These storms begin when ocean water reaches temperatures around 80 degrees
Fahrenheit. The warm water then evaporates into a low-pressure system that causes the tropical
storm to gain momentum and energy. Once these storms achieve a certain wind speed, the
classification changes [41]. Table 9 details each of these classifications.
Table 9. The Saffir-Simpson hurricane wind scale

Table 9 classifies each stage of a hurricane. These storms are recognized when the wind
speed reaches over 39 miles per hour. Recognition to these storms start at wind speeds of 74
miles per hour and can top over 251 miles per hour. Since 1924, there have only been 33
category 5 hurricanes recorded. Some well-known Category 5 hurricanes were Hurricane
Katrina (2005), Hurricane Camille (1969), and Hurricane Hugo (1989) [42].
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Figure 18. Hurricane Katrina on August 28, 2005
Figure 18 shows that the span of Hurricane Katrina on August 28, 2005. At this time,
Katrina was still classified as a Category 5 hurricane. The rain bands of Katrina covered the
majority of the Gulf Coast between Louisiana and Florida, with the body itself extending into the
Gulf of Mexico. Although weakened when the storm entered the Gulf of Mexico, the storm still
had an incredible 30 feet storm surge. It was the storm surge that breached the many protections
put into place to protect areas from such storms. These storm surges show that the best plan of
action when dealing with a hurricane is to evacuate [42].
2.4.4 Sea Level Rise Due to Climate Impacts
The Intergovernmental Panel on Climate Change (IPCC) reports that the global mean sea
level is rising. The warming of the ocean, the loss of ice in the polar ice caps, and the reduction
of liquid water in aquifers and lakes on land cause SLR. The IPPC has come up with several
models on how the sea level could rise by 2100 [43]. Figure 19 displays a few of the SLR
models.
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Figure 19. IPCC scenarios for SLR
The IPCC’s models show that the sea level could rise anywhere between 0.2 m (lowest) to
2.0 m (Highest). If the worst case of 2 m SLR were to occur, over 29% of the U.S. population
would be affected, and over 60% of coastal developments would be threatened [43].

2.5

Concluding Remarks
Natural disasters are a serious matter. While they can be at best unpredictable, there is

still a good amount of planning that can be performed to prevent the worse from happening.
These preparations include hardening of infrastructure to help protect people and educate them
about the natural disasters common in the area. The primary step of preparing the general public
requires risk mapping through simulations of these events. Through computer simulations, it
will be possible to determine areas that will most likely be affected by a natural disaster.
Another use of simulations would allow for preventative maintenance of aged infrastructure
assets. Simulations are also useful for informing a population of what could happen in a natural
disaster. The following two chapters present methodology for simulation of two natural

37

disasters: 2 m SLR and 2 m tsunami. These two simulations are used to determine hot spots that
will be affected by these two natural disasters for key coastal cities.
The use of information technology (IT) and mobile devices provide the best
communication method for emergency management and public awareness during natural
disasters [44]. These IT and mobile tools have already been helping agencies staff for design,
constructional and asset management of infrastructure systems [45].
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CHAPTER III
GEOSPATIAL AND COMPUTATIONAL MAPPING OF COASTAL HAZARDS FOR U.S.
3.1 Remote Sensing Data Sources
Traditional technologies such as aerial photography, and ground surveying are used to
collect data. With rapid developing technologies, the time spent performing field work is
reduced. Such technologies use high-resolution satellite imagery to obtain the data that is needed.
Such data includes digital elevation models, transportation corridors, or land use and land cover
data [46]. Remote sensing data sources are explained in detail in section 1.3.
Remote sensing technologies have some key advantages. Remote sensing data are
digitally stored. Digitally formatted data allows for easier and quicker access to the data by
anyone. Another advantage is that it saves more time than traditional methods that require field
measurements. Next, a wider area can be covered through the use of remote sensing. Finally,
weather and other topographic constraints do not limit remote sensing technologies
The remote sensing data used in Los Angeles was the SRTM 1 Arc Second Digital
Elevation Model (DEM), river shapefiles, the metropolitan annexation shapefile, hydrograph
data, and the NLCD (2011). The remote sensing data obtained for Miami, Florida included
SRTM 1 Arc-Second DEM, and Landsat-8 imagery.
The SRTM 1 Arc-Second DEM was developed by the USGS apart of the National
Elevation Dataset (NED). The NED has the highest resolution and best quality of elevation data
that is available for the entire U.S. The purpose of the NED is to provide elevation data that has
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a seamless form and contains a consistent datum, elevation units, and projection. The SRTM 1
Arc-Second DEM has an absolute vertical accuracy of 2.4 meters with a relative vertical
accuracy of 1.64 meters. The DEM contains pixel cell sizes of 30 meters by 30 meters. This
DEM dataset is available for the entire United States. The DEM was obtained for Miami, and
Los Angeles to perform two simulations [46]. Figure 20 displays the DEM obtained for Los
Angeles, California.

Figure 20. DEM for Los Angeles, California
The DEM obtained for Los Angeles study area showed that the highest elevation is 255
m and the lowest elevation was 0 m. The DEM obtained for Miami study area shows that the
highest elevation is 50.4 meters and the lowest elevation is -2.8 meters
A second remote sensing tool that was acquired was the metropolitan boundary for Los
Angeles [47]. This metropolitan boundary displays all the land that has been annexed by the city
of Los Angeles to form the metropolitan area. Some areas, however, have not been annexed by
Los Angeles. These areas include Beverly Hills, and Santa Monica. This shapefile was also
obtained to be able to determine what part of the study area was Los Angeles.
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The river shapefile for Los Angeles was also obtained [48]. This shapefile would be used
to perform one-dimensional extreme rainfall flood simulation for the greater metropolitan area.
Once downloaded from NOAA, four rivers were selected for the extreme rainfall flood
simulation. These four rivers are:


The Ballona wetlands, located near the airport,



The Los Angeles Aqueduct, which flows throughout the greater metropolitan area of Los
Angeles,



The San Gabriel River, which flows through the Port of Los Angeles, and



The Santa Ana River, which flows through the Port of Los Angeles and Port of Long
Beach
The final remote sensing data that obtained for Los Angeles was NLCD imagery. The

NLCD classifies the entire United States by land use and land cover [49]. The NLCD was used
to determine what type of infrastructure features would be affected due to the 2 m SLR, 2 m
tsunami WPH and the 1-D extreme rainfall flood event.
Landsat-8 imagery was acquired for the city of Miami, Florida. Landsat-8 imagery
contains 11 bands that have spatial resolution between 15 meters and 100 meters. The satellite
imagery was obtained through the USGS EarthExplorer service [50]. Figure 21 shows the
satellite imagery that was obtained and clipped to the study area.
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Figure 21. Landsat-8 imagery of Miami, Florida
Landsat-8 imagery originally normally are of 183 square kilometer swaths. Once the
imagery was obtained, the software. EARDAS IMAGINE 2013 was utilized to pansharpened
and chip to fit the study area [51]. This process improved the spatial resolution of the imagery
from 100 m to 30 m.
With the satellite imagery obtained, the next step was to determine the boundary of the
city of Miami, Florida. The chancery clerk’s office contains several shapefile such as roads, city
districts, and rivers [52]. This boundary would be the area that the process of planimetrics and
LBANS were performed.
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Other data resources that were used was Google Earth and the United States Census
Bureau. The software of Google Earth was used to determine classification in manual
planimetrics better and to determine road, city and river locations [53]. The United States
Census Bureau provide population data for the two cities so that the population at risk could be
determined [54].
This data was used to create spatial maps displaying the planimetric features of the study
area, the impacts from the 2 m SLR simulation, the 2 m tsunami WPH simulation and the 1-D
extreme rainfall flood simulation.
3.2

Geospatial Mapping of Infrastructure Planimetrics for Miami, Florida
Planimetrics was created for the Miami, Florida study area though the software

GeoMedia Professional 2013 [55]. The process of planimetrics involves creating the different
land use features that can be seen and determined. The research methodology for planimetrics
includes the following main steps:
1. Collect Landsat-8 imagery for the study areas.
2. Create pan-sharpened images of the selected study areas.
3. Develop the planimetric and LBANS classifications for each location.
4. Compare the results from the planimetrics and the LBANS classification.
An example of a feature class would be a highway or a river. This process took approximately
50 hours to complete for the 55.25 mi2 (143.1 km²) city. Figure 22 shows the infrastructure and
land use map for Miami.
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Figure 22. Infrastructure and land use features for Miami, Florida created through planimetrics.
The city of Miami has over 400,000 thousand people in it. The population within the city
limits does not account for the 2.5 million people living in the metropolitan area [54]. Key
infrastructure assets in the area include the Port of Miami, Interstate 95, Interstate 195 and
Interstate 395. These key infrastructures are vital lifelines to Miami. If they were to be damaged
or inoperable countless people would be affected.
The second geospatial mapping of infrastructure that was performed for the Miami area
was LBANS. The LBANS process looks at the spectral reflectance value of a pixel to determine
a classification based on decision tree criteria. Table 10 displays the decision tree criteria that
was used.
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Table 10. LBANS multispectral decision tree criteria and workflow to auto-classify surfaces
classes

Steps

0

1

2

3

4
5
6
7

8
9
10

LBANS Multispectral Decision Tree
Criteria for Surface Discrimination
Define geospatial boundary of area of
interest (AOI)
Total pixels = N
Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050
Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302
Grass (NG)
NG < (N - NW - NT)
6,935 ≤ SWIR 2 Band ≤ 12,798
Soil (NS)
NS < (N - NW - NT-NG)
11,239 ≤ SWIR 1 Band ≤ 26,802
Natural terrain (NN)
NN = (NW + NT + NG + Ns) < N
Built Infrastructure (NI)
NI ≤ (N - NN)
Building (NB)
NB < NI
7,428 ≤ Green Band ≤ 20,339
Concrete (NC)
NC < (NI - NB)
8,103 ≤ NIR Band ≤ 16,945
Asphalt (NA)
NA ≤ (NI – NB – NC)
Check unclassified (NU) pixels
NU = N – NN – NB – NC – NA
Total pixels remaining

45

Surface
Class
Legend
Color

Spectral
Range

Yes
(if
needed)

Blue

± 2SD

No

Dark Green

± 2SD

No

Light Green

± 2SD

No

Yellow

± 2SD

Magenta

± 2SD

Yes
(if
needed)

Orange

± 2SD

No

Gray

No

White

Polygon
Map

Yes

Table 10 displays the decision tree criteria to perform LBANS. There were two main
requirements for LBANS. The first is that a high autocorrelation R value of the surface exists
within the band. The second was that unique ranges and spectral reflectance values were used
for each surface class.

It is based on two standard deviations of the spectral reflectance for

unique bands. The criteria are generated through functional attributes in the software GeoMedia
Pro. These functional attributes will look at every pixel in a study area and define every pixel.
Once a step is completed a spatial difference was used to remove the classified pixels from the
dataset, and the next step was performed. Figure 23 displays the results for LBANS for Miami,
Florida.

Figure 23. LBANS classification for Miami, Florida.
Once the two methods were completed, the results were compiled into a table to be
compared with each other.
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Table 11. Comparison between planimetrics and LBANS classification for Miami
Surface Class

Planimetrics

A Asphalt

m2
8,525,524

Percent
Area
%
6.96

B Building
C Concrete
BC
Building/Concrete
G Grass

52,773,228
11,157,386

S Soil
T Tree
W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building/Concrete,
Asphalt)
Total Natural
Surface
(Soil, Trees, Grass,
Water)
SUM

m2
832,050

Percent
Area
%
0.68

Percent
Difference
%
6.28

43.10
9.11

1,920,825
500,175

1.57
0.41

41.53
8.70

63,930,613

52.21

2,421,000

1.98

50.24

9,122,647

7.45

33,325,650

27.22

-19.77

2,251,749
10,926,615
27,684,028
0
122,441,175
72,456,137

1.84
8.92
22.61
0.00
100.00
59.18

8,935,425
48,129,750
28,797,300
0
122,441,175
3,253,050

7.30
39.31
23.52
0.00
100.00
2.66

-5.46
-30.38
-0.91
0.00
0.00
56.52

97.34

-56.52

(72.46 km2)
49.985.038

(3.25 km2)
40.82

(49.98 km2)
122.441.175
(122.44 km2)

LBANS

119.188.125
(119.19 km2)

100.00

122.441.175
100.00
(122.44 km2)
MARE = 1.6982%
RMSE – 26,116,502.82 m2

0.00

Table 11 displays the results of both the planimetric and LBANS classification. There
was no difference in the area that was calculated. Planimetric mapping and LBANS
classification both showed a high percentage of building and concrete features as well as water.
The main difference was in the classification of asphalt. LBANS classified over 44.28% of
Miami as asphalt. The large classificaiton of asphalt is what LBANS classifies. LBANS looks
at an entire pixel that represents an area of 225 km2 which is based on spectral reflectance.
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Manual planimetrics looks at satellite imagery to determine the surface type. Also, planimetrics
is performed by the user and error can be involved.
Once the manual planimetrics and LBANS for Miami were completed, the Mean
Absolute Relative Error (MARE) and the Root Mean Square Error (RMSE) were calculated to
compare the two methods. MARE is a statistical accuracy measurement that is used to filter out
the most optimal models. The closer the MARE value is to zero, the better the model’s
performance. MARE is calculated using Equation 2. This equation is from Najjar’s research
paper [56].
N

 yˆ i  yi 

 yi 

 
MARE =

i 1

N

x 100

(2)

RMSE is used to measure the difference between values predicted by the model (LBANs)
and measured values (planimetrics). RMSE is an indicator of model accuracy or
precision. RMSE should be as close to zero as possible. RMSE is calculated using Equation
3. This equation comes from an academic journal paper [57]
N

y
RMSE =

i 1

i

2
 yˆ i 

N

(3)

Where;

yi = the observed values (Planimetrics)
ŷi = the predicted values (LBANS)
N = total number of data sets (7 surface classes)
The analysis showed that the MARE value is 1.6982%, and RMSE is 26,116,502.82 m2.
The MARE being close to zero shows that LBANS performed well.
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3.3

Geospatial Analysis of National Land Cover Database for Los Angeles, California
Since 2001, the Multi-Resolution Land Characteristic Consortium (MRLC) has released a

new national land cover (NLCD) database in five-year increments. The Consortium represents
interested groups that have a need for understanding land cover change for the conterminous
United States (CONUS). Such agencies include the United States Geological Survey (USGS),
the National Oceanic and Atmospheric Administration (NOAA), and the United States Forest
Service. Uses for the NLCD dataset include land management, hydrology, telecommunications,
and risk analysis. Figure 24 shows the spatial map of NLCD for the conterminous United States
[58].

Figure 24. NLCD for the conterminous United States
3.3.1 Description of the National Land Cover Database
Figure 24 displays the NLCD for the conterminous United States. The NLCD is based on
Landsat imagery and contains information about the land use and land cover database. This
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database divides the United States into 30 by 30 meter cells to provide spatial and descriptive
data for the overall characteristics of the surface type within the cell. There are 21 different
categories that each cell could be, such as water, forests, or urban areas. Figure 25 shows the
NLCD surface class legend [59].

Figure 25. NLCD surface classes
Within these surface classes, there is a classification for different types of forests,
wetlands, fields, even developed areas. While the NLCD dataset that is being used for the
contiguous United States does not include Alaska and Hawaii, the legend is also tailored for
those states. The * denotes that it only applies to Alaska and Hawaii [59]. Figure 26 shows the
simplified classification for the contiguous United States for the year of 2011.
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Wetlands
5.17

Cultivation
36.72

Area of the
Continuous US:
9,631,420 m2
Soil
22.84

Urban
5.62
Water
5.24

Forest
24.4

Figure 26. NLCD simplified classification for the conterminous United States
As mentioned before, the NLCD describes how the area in CONUS is used. Since the
NLCD dataset is updated every 5 years; it can be determined how land use has changed over
time. This means that the dataset can help assess issues like urban sprawl, deforestation,
drought, or population change. Current produced datasets have provided the percent of land use
change for the periods of 2001 to 2006, 2006 to 2011, and 2001 to 2011.
The MRLC is currently in development of the 2016 NLCD. However, the process to
finish the NLCD is time-consuming, and the results will not be available till late 2017. A
detailed step by step process for the formulation of the NLCD is discussed in section 3.3.2 [59].
3.3.2 Design of the National Land Cover Database
There are several steps involved with the creation of the NLCD. The first step is the
collection of the data that will be used. The imagery that is used to classify each pixel is
provided by the USGS Earth Resource Observation and Science (EROS) center Landsat
archives. From the EROS archives, two sets of Landsat 5 imagery are taken from each scene.
These two sets are from the summer and winter months. This is to account for the differences
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when the season's change and land are used differently. For example, some cultivated land is
barren, or deciduous plants lose their leaves. These subtle differences affect the classification of
each cell.
With the imagery set, the next step take was to convert the digital number reflective
bands into Top of Atmosphere (TOA) reflection. The conversion process is performed to allow
all the bands within the Landsat imagery to be used during classification processes.
Once the Landsat imagery has been chosen and converted, the next step is to classify the
dataset. The NLCD for 2011 has two major changes to the classification process from the
previous two years (2001, 2006). The first is the NLCD for 2011 uses two sets of imageries
from the on leaf and off-leaf periods. The second is the use of a new comparison method. The
method used is called the Multi-Index Integrated Change Analysis (MIICA) model. The MIICA
model uses multiple indices for determination of classification, such as recognition for
complementary indexes and sensitivity of the indexes.
Through extensive efforts, the dataset is classified using MIICA model and is ready to be
distributed in four main forms: the NLCD 2011 dataset, land cover changes from previous year’s
datasets, tree canopy cover maps, and percent impervious change [59].
3.3.3 Geospatial Analysis for Los Angeles, California using the National Land Cover Database
The NLCD spatial map was downloaded and interpreted for the study area of Los
Angeles, California. The interpretation and analysis were performed using the program
EARDAS IMAGINE 2013 [51].
The first step in performing an analysis for the Los Angeles area was creating the study
area that was going to be studied. The focus was to include important infrastructure assets in the
study area. The Los Angeles Airport, the Port of Los Angeles, and the Port of Long Beach were

52

included. Figure 27 shows the area that was selected for the study area.

Figure 27. Study Area of the metropolitan area of Los Angeles and surrounding areas
It was important to choose the study area based on a few criteria. First, it needed to
include the major population areas of the area. This was because the simulation that would be
performed later would detect how the population of Los Angeles would be affected. The second
main criteria were that major infrastructure would also need to be included. For the Los Angeles
study area, it was important to include the Port of Los Angeles and the Port of Long Beach as
well as other critical infrastructure such as the Los Angeles Airport.
With the study area selected, the next step was to subset and chip the NLCD imagery to
obtain a more reasonable study area dataset. Using the Inquire box dimensions of 45 meters by
55 meters and the subset and chip tool, the region was then subset and chipped to provide the
study area. The Subset and Chip tool dialogue box is shown in Figure 28.
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Figure 28. Subset tool dialogue window
There were a few options selected in the dialogue window. The first was choosing the
input file and output files. The input file was of the 2011 NLCD dataset, and the output file was
saved as NLCD_Subset_LA. It was important to note what the output file was because it would
need to be added back into the EARDA IMAGINE viewer later for analysis. The next option
was to choose the From Inquire Box. This would ensure that the four corner coordinates would
be selected from the Inquire box. This ensured that the area that would be snipped would be of
the actual study area. Finally, the Ignore Zeros in Output Stats was selected. This option is
used to make sure that the values for the null space were not included in the classification. This
blank area was adjusted for later during the Unsupervised Classification. Once the options were
selected, the subset operation was performed. Figure 29 shows the results with an ocean
shapefile added.

54

Figure 29. Los Angeles study area (45 m x 55 m)
With the study area defined, the next step was to see what type of features the Los
Angeles region had. This was done by selecting the subset imagery and selecting the Table
option under the Raster tab. Once the table tab was open, the Show Attributes was then
selected. This opened the attribute table for the entirety of the study area. Figure 30 shows some
of the attributes of the study area, while Table 12 shows the summary of the entire study area.

Figure 30. Sample of the table of attributes from the Los Angeles study area.
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Table 12. NLCD (2011) classification table for the Los Angeles study area
NLCD Land Cover and Land

Pixels in

Area Occupied by Each

Classification

Use Classification

Category

Category (km2)

Summary

Open Water

427,137

384.4233

Open

Developed, Open Space

165,718

149.1462

Built

Developed, Low Intensity

315,447

283.9023

Built

Developed, Medium Intensity

1,104,467

994.0203

Built

Developed, High Intensity

534,817

481.3353

Built

Barren Land

6,264

5.6376

Open

Deciduous Forest

150

0.135

Open

Evergreen Forest

2,884

2.5956

Open

Mixed Forest

5,986

5.3874

Open

Shrub/Scrub

30,228

27.2052

Open

Herbaceous

29,146

26.2314

Open

Hay/Pasture

215

0.1935

Open

Cultivated Crops

5,063

4.5567

Open

Woody Wetlands

1,544

1.3896

Open

2,081

1.8729

Open

Total Pixels Classified

2,631,147

2,368

Total Built Up Area

510,698

460

Total Open Area

2,120,449

1,908

Emergent Herbaceous
Wetlands

From the table, it is seen that NLCD data covers only 2,368 km2. However, the study
area encompasses 2,475 km2. There is a shortfall in what was covered. In the ocean, there was
an unclassified area that showed as a black area. This black area was classified as zero values
for the imagery and was later reclassified as an Ocean feature. This is where the shortfall was.
The area of the black void area was approximately 114 km2. Another location the difference
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could be found is in the pixels that were cut in half when the study area was formed.
Once it was known what the Los Angeles area contained, Unsupervised Classification
was performed to obtain two surface types for the Los Angeles area, built infrastructure and open
area. The unsupervised classification process was started by selecting the Raster tab, followed
by the Classification tab, and then finally the Unsupervised Classification option. Figure 31
shows the Unsupervised Classification dialogue window.

Figure 31. Unsupervised classification dialogue window
Within this window, the following options were selected and defined: the output cluster
layer, the Isodata method, the Classify zeros check box, and the to was changed to 6. Through
the classification, each pixel was changed into one of seven classes based on pixel color. The
classification results are shown in Table 13, and Figure 32 shows the unsupervised classification
imagery.
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Table 13. Unsupervised classification results

Unsupervised
Classification Class
Class 1
Class 2
Class 3
Class 4
Class 5
Class 6

New
Classification
Water
Built
Built
Built
Built
Non-Built

Pixels
543,345.00
165,718.00
315,447.00
1,104,467.00
541,231.00
77,147.00

Figure 32. Unsupervised classification imagery.
The classification included six different feature classes. They were water, four built
infrastructure, and the non-built class. This was further reduced to the two feature classes of
built infrastructure and open areas. Table 14 shows the area that the built infrastructure and open
area classes occupied.
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Table 14. Built infrastructure and open area from unsupervised classification summary

Classification

Pixels in

Area Occupied by

Area Occupied by

Each Category

Each Category

(m2)

(km2)

Category

Built Infrastructure

2,126,863

1,914,176,700

1,914

Open Area

620,492

558,442,800

558

Unclassified

0

0

0

Total Pixels Classified

2,747,355

2,472,619,500

2,473

From this table, it is seen that of the study area, over 1,900 km2 were built infrastructure,
and only 558 km2 were open. This makes sense due to the fact the Los Angeles metropolitan
area has a population of over 12.8 million people, and then the surrounding Orange County and
San Bernardino County contain even more people. With the pixel classification know, the
surface type map was changed to more appropriately align colors for the study area. Figure 33
shows the Los Angeles study area with six major areas defined.

Figure 33. Unsupervised Classification for Los Angeles
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Four main classifications were found in Los Angeles. They are open areas, water,
asphalt, and concrete. As seen in Figure 33 and Table 14, over 78% of Los Angeles is built up
area. If a major natural disaster such as a flood or tsunami were to hit this area, there would be
disruption to commerce and people lives. Also, hampered would be the recovery effort because
major transportation would be limited. Transpiration such as the port or airport is at risk due to
the proximity to the ocean.

3.4

Simulation of Sea Level Rise and Tsunami Hazards and Their Impacts
Los Angeles and Miami have two things in common. The first is that they are major

cities in their respected side of the United States. The second is that they are key port cities. In
section two, it was mentioned that SLR and tsunamis are natural hazards for coastal cities. This
thesis performed two simulations in both cities: a 2 m SLR simulation and a 2 m tsunami WPH
simulation. Both simulations were performed in ArcGIS. The first simulation that will be
discussed is the 2 m SLR, followed by the 2 m tsunami WPH simulation.
NOAA and the IPCC have claimed that by the year 2100, the global mean sea level could
rise 2 m. This is due to rising temperatures, the melting of the polar ice caps, and the depletion
of water stored underground in aquifers [43]. If the worst case of SLR were to happen over 39%
of the United States population and 60% of the future developable land on the coast will be at
risk. The higher sea levels would mean more destructive storm surges would occur further
inland [41]. This is a huge problem with tropical storms such as hurricanes. One of the main
destructive force of such storms is the resulting storm surge. An example of this can be seen
through Hurricane Katrina where the storm surge was measured to be over 25 feet in some areas
[42]. The aim of the 2 m SLR simulation is to determine the population and critical
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infrastructure at risk. The methodology that was used was developed by CAIT and includes the
following main steps:
1. Create a spatial map of DEM elevation ranges.
2. Create a shapefile of the 2 m SLR.
3. Classify areas below the 2 m SLR elevation as submerged land.
The methodology can also be seen in Nyguen Ph.D. dissertation [62].
The first step in performing the 2 m SLR simulation was to create a spatial map of the
elevation ranges for the study area. This is based on the DEM remote sensing data that was
obtained for both Los Angeles and Miami.
The second step was to create a shapefile of the shoreline. The creation of the shoreline
would allow the simulation to determine the area of the ocean and would not calculate this into
the newly inundated land.
The next step was to create the 2 m SLR shapefile. This was done by subtracting the 2 m
and below elevation ranges from the rest of the elevation data. Once compiled, the areas in the 2
m SLR feature were classified as submerged land.
Figure 34 displays the results of the 2 m SLR simulation for Los Angeles, while Figure
35 shows the results for Miami.
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Figure 34. Results of the 2 m SLR simulation for Los Angeles

Figure 35. Results of the 2 m SLR simulation for Miami.
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Figure 34 displays the results from the 2 m SLR simulation for Los Angeles. The main
areas that were affected were the Port of Los Angeles and the Port of Long Beach. The airport,
commercial districts, and residential areas were not affected much. The land submerged from
the simulation was 33.76 km2. This affected over 215 thousand people would be affected from
this simulation. SLR would barely be noticeable in Los Angeles. This is due to the fact Los
Angeles has a low coastline, but as one travels away from the coast, they rise in elevation.
Figure 35 displays the results of the 2 m SLR simulation for Miami. There were over 720
km2 affected from the simulation. This shows that over 1.43 million people are at risk in the
Miami-Dade metro area. This makes sense because Miami is flat is primarily located on the
low-lying ground because Florida mainly consists of swamps.
One main limitation of SLR is that it cannot consider barrier islands. The simulation
method requires that the shoreline is streamlined and does not contain any gaps or loops.
A 2 m tsunami WPH simulation was also performed in Los Angeles and Miami. A
tsunami is an event that can be caused by an earthquake in the ocean. While historically
tsunamis are well known to have waves over 5 meters a typical case is 2 m high [63]
The data that the tsunami simulations was based from the 2011 Japan tsunami. Fritz,
Phillips, etc. used LiDAR and eyewitness video recordings to recreate the tsunami ray and
velocity [64].
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Table 15. Tsunami height time series analysis from the 2011 Fukushima tsunami.
Tsunami
Step

Time

Wave
Height

Time
Interval

Cumulative
Arrival

Distance At
Velocity

Time

Each
Interval

Cumulative
Distance

(hh:mm)

(m)

(minute)

(minute)

(m/s)

(m)

(m)

1

15:26

0.00

0

0

3.00

0

0

2

15:29

0.86

3

3

4.00

720

720

3

15:31

1.46

2

5

4.30

516

1,236

15:33

2.00

2

7

4.70

564

1,800

5

15:36

1.35

3

10

4.90

882

2,682

6

15:39

0.82

3

13

4.00

720

3,402

7

15:42

0.57

3

16

11.00

1,980

5,382

8

15:50

0.31

8

24

9.20

4,416

9,798

9

16:00

0.21

10

34

7.10

4,260

14,058

10

16:10

0.10

10

44

5.00

3,000

17,058

11

16:19

0.00

9

53

4
(peak)

12

95

29.8 km
Return of water to the shore

Table 15 displays a sample of how the 2011 tsunami acted. The total distance that the
tsunami traveled was 29.8 km. The event lasted 53 minutes. This is the time from when the first
wave hit land to when the waves finally subsided back to the ocean [64]. From this data, a
simplified version of the tsunami wave was formed where the maximum wave height was 1 m.
Figure 36 shows this graph.
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Figure 36. Normalized peak value of tsunami wave height.
With a normalized peak wave height distribution, simulations could be developed for a
variety of ranges. The simulation method developed by CAIT researchers contains the following
main steps:
1. Create a shoreline and define the simulation area.
2. Create a shapefile of depth submerged by the 2 m tsunami WPH.
3. Overlay submerged land area from the 2 m tsunami WPH simulation on the metropolitan
boundary area map.
4. Evaluate the impact of a 2 m tsunami WPH on infrastructures and population.
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Figure 37 and Figure 38 shows the results of the 2 m tsunami WPH simulations for Los Angeles
and Miami.

Figure 37. Results of the 2 m tsunami simulation for Los Angeles metopolitan area
Figure 37 displays the results of the 2 m tsunami simulation for Los Angeles. The
simulation shows that 26.14 km2 would be submerged by a 2 m tsunami. The respective time
that this tsunami would last is 53 minutes. The simulation showed that key infrastructure assets
are at risk in the Port of Los Angeles and the Port of Long Beach. Also affected is a small
private marina in the North-West corner of the figure. The simulation places around 167
thousand people at risk in the Los Angeles area.
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Figure 38. Results of the 2 m tsunami simulation results for Miami
The results for the 2 m tsunami simulation for Miami is shown in Figure 38. The results
show that in the Miami area over 411 km2 were submerged due to the 2 m tsunami wave. This
put over 1.4 million people at risk in the metropolitan area. The simulation showed that the Port
of Miami, the Miami-Dade International Airport, and several highway systems in the area were
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affected in this area.
One crucial limitation of both simulation methods is that it only considers ground
elevation. The elevation of structures is not factored in. These structures act as a type of
protection barrier from the wave and would force it to stop, change directions or lose velocity.
Table 16 displays the results of the three simulations performed for Los Angeles and
Miami.
Table 16. Computer Simulation results for Los Angeles and Miami

Simulation

2m SLR

2m Tsunami
Rainfall 1-D
Flood

Los Angeles, CA

Miami, FL

Submerged land

Submerged land

(% of Land Area)

(% of Land Area)

33.76 km2

411.96 km2

(1.68%)

(57.08%)

26.14 km2

411.96 km2

(1.30%)

(57.08%)

747.06 km2
(37.23%)

Through a comparison of these three simulations events, it can be seen that rainfall
flooding has the most potential to affect infrastructure and people. However, tsunamis prove to
be more disastrous to people. This is seen through the reaction times that each disaster provide.
The reaction time associated with tsunamis is smaller than SLR and rainfall floods. Tsunamis
events occur over a few hours, and over little warning to when they occur. Rainfall floodings
offer a longer reaction time of only a few days. Finally, SLR is projected to occur over the next
century.
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3.5

Rainfall Simulation for Los Angeles Area and Economic Impacts
The 1-D rainfall simulation for Los Angeles and the surrounding area required

hydrograph data for a rainfall event for the area. The hydrograph data obtained was from the
USGS rainfall and river gage data from a rainfall event in January 2005 [65]. Figure 39 shows
the hydrograph data that was obtained.

Figure 39. Simulation hydrograph of 19-day rain event for San Gabriel River California
This rain event happened over an 18-day span in January. The rain event had a peak
discharge rate of 838.2 m3/s. This data is consistent with a 100-year rainfall flood event defined
by NOAA.
The first step to perform the 1-D rainfall flood simulation was to create a triangular
irregular network (TIN) from the DEM for the area. This was done through the geospatial
software ArcGIS [66]. Once the TIN was created, river centerlines, cross sections, river banks,
and other features were created. Figure 40 displays a spatial map of the Los Angeles study area
overlaid on the DEM and displays the analyzed rivers.
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Figure 40. Los Angeles DEM and cross sections for 1-D rainfall flood simulation.
With the river features and TIN created, the next step was to use the HEC-GeoRAS
software to change the two-dimensional features into three-dimensional features that accounted
for the elevation [67]. This allowed the simulation to account for the flat area and higher
elevation. Once the features were transformed, the 1-D extreme rainfall flood simulation was
performed. Figure 41 shows the results from the simulation.
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Figure 41. 1-D extreme rainfall flood simulation for Los Angeles
The simulation showed that over 747 km2 of land are at risk to extreme rainfall flooding.
The population of the Los Angeles metropolitan area is around 12.8 million people. This rainfall
flood simulation showed that over 4.5 million people are at risk due to this type of flood.
In the United States, the condition of the existing infrastructure is evaluated every year by
the American Society of Civil Engineers (ASCE). The most recent report card for 2017 reports
shows that the condition is a D +. Table 17 displays how some of the infrastructure assets of the
United States scored [68].
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Table 17. Summary of the 2017 ASCE infrastructure report card
Infrastructure

Grade

Infrastructure

Grade

Bridges

C+

Dams

D

Rail

B

Roads

D

Ports

C+

Transit

D-

With the state of infrastructure being so poor in the United States, it is important to
understand the cost associated with the aged infrastructure. This cost is the Maintenance,
Rehabilitation, and Reconstruction (M, R & R) associated with the infrastructure. The M, R & R
cost is what it would cost to maintain, repair and replace infrastructure for maintenance or
reconstruction. In his Ph.D. dissertation, Wodajo discussed the M, R & R cost related to
infrastructure damage for Gulfport, MS, based on information from before Hurricane Katrina.
Equation 4 is the model that Wodajo used to calculate M, R & R costs for Gulfport [69].
Ý = 84,856 X – 496,308

(4)

where;
Ý = predicted total M, R & R cost, $ per km2 of study area.
X = pre-flood built-up area, % of study area
The model displayed in equation one was used to calculate the M, R & R cost related to
infrastructure damage for the Los Angeles area. The study focused on an area of 45 m by 55 m.
The pre-flood built-area was determined using two different spatial maps of the area.
The first method of determining the built infrastructure area in Los Angeles was found
using the spatial map of the NLCD (2011). The total area the built infrastructure covered was
1,914.17 km2. Figure 42 displays the NLCD (2011) for the Los Angeles metropolitan area. The
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second method of determining the built infrastructure for Los Angeles was using the Los
Angeles annexation metropolitan map. The total area of built-up area was determined to be
1,414.12 km2. Figure 43 displays the spatial map of the Los Angeles metropolitan area.

Figure 42. Spatial map of the NLCD (2011) for Los Angeles

Figure 43. Spatial map of the Los Angeles metropolitan area
Table 18 displays the area and the percent of the study area that each respective spatial
map covers.
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Table 18. Area of Built Infrastructure in the Los Angeles Area
Spatial Map

Area (km2)

Percent of Study Area (%)

NLCD (2011)

1,914.17

77.34

Los Angeles Metropolitan area

1,414.62

57.16

With the pre-flood area determined, the next step was to calculate cost estimates of
potential infrastructure damages. By applying the M, R & R equation developed by Wodajo, the
unit cost and the total cost could be determined [69]. Table 19 displays the results.
Table 19. Results of M, R & R analysis
Unit cost ($/km2)

Total Cost ($)

NLCD (2011)

$6,066455.04

$15,014,476,224.00

Los Angeles Metropolitan area

$4,353,751.88

$10,757,535,899.16

Spatial Map

From the above two cost estimates of infrastructure damage and economic loss, the lower
cost estimate of $10.8 billion (USD) calculated using the Los Angeles Metropolitan boundary is
the more reasonable cost estimate. This cost estimate is adequate for overall economic risk
associated with catastrophic flood disasters and to secure funding for resilience strategies.
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CHAPTER IV
GEOSPATIAL AND COMPUTATIONAL MAPPING OF COASTAL HAZARDS FOR
GWADAR, PAKISTAN
4.1 Background of Gwadar Port Study
Gwadar is located in the Balochistan province of Pakistan, at the entrance to the Gulf of
Oman and the Persian Gulf. The location of Gwadar allows for quick access to offloading ships
and moving goods and will eventually be connected to the Silk Road project. This project will
give critical access to allow goods to be delivered not just across the country but also
internationally to China and Afghanistan. Given the rapid growth that is projected for the area,
it was deemed important for Pakistan to develop a new deep harbor and container port, as well as
a liquid natural gas hub [70]. Figure 44 shows the location of Gwadar in relation to the Persian
Gulf.

Figure 44. Location of Gwadar from Google Maps
The new trade route follows the old silk road and will connect China to the Arabian Sea.
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China’s plan is to have a network of ports, railways and highways that snake throughout Asia
into Europe and Africa. Not only will this trade network benefit China’s economy but it will
also stimulate the economies of every country that the network travels through, with the first
being through Gwadar [71].
Currently, China receives over 50% of its oil from the Middle East. The primary route is
through the ocean to arrive at the eastern port cities. This route is too long seeing as how the
transport ships have to travel around India and through the narrow straights around Malaysia and
Indonesia. Not only will China ship oil through the port but it will also use the port to access the
vast trade network within the Persian Gulf and the Arabian Sea. Out of the $48 billion (USD)
that is planned to be invested, $35 billion (USD) is earmarked for energy [72].
The importance of this port is crucial to the growth of Pakistan. In 2013, Pakistan agreed
on a plan with the International Monetary Fund that helped stabilize its economy. However, due
to the poor infrastructure and crippling power shortages, the Pakistan economy has suffered
greatly. According to an article by Arshad Hussain, total exports from Pakistan fell 12.11% in
2015-2016 [73].
The Balochistan province has a 38% investment stake in the port. The port is also
creating jobs for the people. The job creation will not only improve the economy but will put an
end to activities that exploit the job deficit in the region [72].
The investment into the port is not all that is being planned. Coal-fire, solar and wind
power plants are being planned. Along with these power plants, a 3,000 km long coastal
highway is being planned. It will run from the Karakoram Highway to the Arabian Sea.

76

4.2 Infrastructure Planimetrics and Geospatial Mapping of Gwadar Pakistan
Geospatial mapping and infrastructure planimetrics were performed for Gwadar,
Pakistan. By using Landsat-8 satellite imagery, the process of manual planimetrics was
performed to determine the land use and land cover for Gwadar. The Landsat-8 imagery was
obtained from the USGS EarthExplorer service [50].

Figure 45. Landsat-8 imagery of Gwadar, Pakistan
Figure 45 shows the study area of Gwadar, Pakistan. The study area includes the main
port that China is investing in and covers over 500 km2. Planimetrics for Gwadar were created
and follow the same methodology performed in chapter three.
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Figure 46. Planimetrics of Gwadar, Pakistan
Figure 46 displays the results of planimetric for infrastructure features for Gwadar,
Pakistan. Gwadar is mostly desert except for the peninsula, which contains most of the built
infrastructure and population. Through future development, Gwadar will expand. Future growth
has already been planned and can be seen on the extensive road network leading out of the
peninsula. However, since the time of capture of the Landsat-8 imagery, there has been
development in Gwadar and there will be the future development of infrastructure to support the
port. Future development includes the completion of a stable transportation system; the port city
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of Gwadar, will be able to grow even more when the port is fully operational. Table 20 shows
the breakdown for each feature type.

Table 20. Land use area by planimetrics for Gwadar
Land use area

Area (km2)

A Asphalt

0.54

B Building

16.33

C Concrete

10.55

BC Building/Concrete

26.88

G Grass
S Soil

447.08

T Tree
W Water

726.17

U Unclassified
Total

1,200.67

Manual planimetrics require that satellite imagery is examined to determine what areas
should be classified. Because of this, there were no trees or grass found. Manual planimetric
showed that much of Gwadar was found to be in soil or water. A second method was used to
evaluate the accuracy of the manual planimetrics.
The classification system that was used is called LBANS. LBANS uses high-resolution
satellite imagery to classify an area based on the spectral reflectance of the pixel. LBANS was
developed as a part of Nguyen’s dissertation [62]. The goal of LBANS was to develop a better
method to classify areas based on satellite imagery. LBANS was performed using GeoMedia
Pro and took approximately 125 hours.
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LBANS requires decision rules to filter out and classify pixels based on the spectral
reflectance.

Table 21. Statistical summary of spectral reflectance for all surface classes for Band 7
(g) Band 7: SWIR 2

Asphalt

Grass

Building

Soil

Concrete

Tree

Water

std dev (SD)

1,890.6 1,465.8

4,598.9

2,999.1

1,742.1

455.1

518.4

m + 2SD

15,439

12,798

24,238

23,380

14,932

7,969

6,574

Mean (m)

11,658

9,866

15,040

17,382

11,448

7,059

5,537

m - 2SD

7,877

6,935

5,842

11,383

7,963

6,148

4,500

Autocorrelation (R)

0.811

0.973

0.860

0.958

0.889

0.917

0.995

Table 21 displays Band 7 which was one of the several Bands used for surface
classification in the LBANS procedure. The decision criteria that was used is based on two main
concepts. The first is that there is a high autocorrelation (R) value for the surface that will be
classified. The second rule is that there must be a unique range. Band 7 was used to autoclassify grass. The autocorrelation R value is 0.973 which is unique. This criterion was used for
all seven surface classifications. Table 22 displays the decision criteria tree for LBANS.
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Table 22. L-BANS multispectral decision tree criteria and workflow to auto-classify surface
classes
Steps
0

1

2

3

4
5
6
7

8
9
10

L-BANS Multispectral decision tree
criteria for surface discrimination
Define geospatial boundary of area of
interest (AOI)
Total pixels = N
Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050
Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302
Grass (NG)
NG < (N - NW - NT)
6,935 ≤ SWIR 2 Band ≤ 12,798
Soil (NS)
NS < (N - NW - NT-NG)
11,239 ≤ SWIR 1 Band ≤ 26,802
Natural terrain (NN)
NN = (NW + NT + NG + Ns) < N
Built Infrastructure (NI)
NI ≤ (N - NN)
Building (NB)
NB < NI
7,428 ≤ Green Band ≤ 20,339
Concrete (NC)
NC < (NI - NB)
8,103 ≤ NIR Band ≤ 16,945
Asphalt (NA)
NA ≤ (NI – NB – NC)
Check unclassified (NU) pixels
NU = N – NN – NB – NC – NA
Total pixels remaining
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Spectral
Range

Yes (if
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Blue

± 2SD

No
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No
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No

Yellow
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± 2SD

Yes (if
needed)

Orange

± 2SD

No

Gray

No

White

Yes

Figure 47. LBANS classification for Gwadar, Pakistan
Figure 47 displays the composite of the LBANS classification. Gwadar was a huge study
area covering over 1,200 km2 of land and ocean. For this reason that the software, GeoMedia
Pro, could not handle the full area at one time. Gwadar was then divided up into four regions to
accommodate the software better.
LBANS also had another discrepancy within it for Gwadar. LBANS classified the
southern peninsula as asphalt. This showed that the two methods needed to be compared check
for accuracy in the LBANS method.

.
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Table 23. Gwadar classification of land use comparison table

m2
A1
542,900
16,325,380
10,550,192

%
A2
0.05
1.36
0.88

m2
B1
20,635,200
1,903,050
114,975

%
B2
1.72
0.16
0.01

Difference
Planimetrics
&
LBANS
%
A2-B2
-1.67
1.20
0.87

26,875,572

2.24

449,227,575

37.41

-35.18

0

0.00

15,701,625

1.31

-1.31

447,076,897

37.24

428,973,975

35.73

1.51

T Tree

0

0.00

7,341,750

0.61

-0.62

W Water

726,172,366

60.48

725,997,160

60.47

0.01

0

0.00

0

0.00

0.00

SUM

1,200,667,735

100.00

1,200,667,735

100.00

0.00

Total Built
Infrastructure
(Asphalt, Building,
Concrete, )

27,418,472

2.28

22,653,225

1.89

0.40

98.11

-0.40

100.00

0.00

Surface Class

A Asphalt
B Building
C Concrete
BC
Building/Concrete
G Grass
S

Soil

U Unclassified

Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

Planimetrics
Percent
(Groundtruth)
Area

97.72

(1,173.25
km2)
1,200,667,735
(1,200.67
km2)

Percent
Area

(22.65 km2)

(27.42 km2)
1,173,249,263

LBANS
Area

1,178,014,510
(1,178.01
km2)

100.00

1,200,667,735
(1,200.67
km2)

MARE = 5.5604%
RMSE = 13,881,059.34 m2

Table 23 shows several differences between planimetrics and LBANS. The most
noticeable difference is between the classification of soil. Planimetrics classified over 37% of
the land area as soil, while LBANS classified only 0.24%. Another difference was the
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classification between building and concrete. Planimetrics classified only 2.24% as building and
concrete, while LBANS classified 37.41% as building and concrete. A developing port city,
such as Gwadar, should have infrastructure and transportation systems to get trade goods to and
from the port.
MARE and RMSE were also calculated between the methods of manual planimetrics and
LBANS. MARE and RMSE are explained in Chapter 3 as a measure of accuracy between two
methods [63, 64]. MARE for Gwadar was calculated to be 5.5604%, while the RMSE was
calculated to be 13,188,059.34 m2. These two measures of accuracy show that the prediction
model of LBANS auto classification performed well. This shows that LBANS is a useful
prediction model for determine land use and land cover classifications.
Key differences between the two methods include:


The time spent performing each method. Planimetrics took around 90 hours to complete.
LBANS took over 130 hours to complete.



Both methods rely on satellite imagery, but LBANS involves the least amount of user
error.



The processing power of the computer is severely hampered with larger study areas. This
was the case with Gwadar. LBANS took hours to load and calculate each pixel.



While Planimetrics seems faster than LBANS, there is a tradeoff. Accuracy is sacrificed
when speed is preferred, and the opposite is true when speed is sacrificed for accuracy.

4.3 Simulation of Sea Level Rise and Its Impacts
As mentioned in Chapter 3 SLR is a global threat. NOAA and the IPCC speculate that
the sea level can rise anywhere between 0.2 m and 2.0 m. For nations with unreliable port
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structures such as Pakistan, this could prove to be a problem. A 2 m SLR simulation was
performed for Gwadar, Pakistan. The methodology to simulate 2 m SLR was previously applied
to Los Angeles and Miami and includes the following main steps:
1. Create a spatial map of DEM elevation ranges.
2. Create a shapefile of the 2 m SLR.
3. Classify areas below the 2 m SLR elevation as submerged land.
DEM data was required for both the 2 m SLR and the 2 m tsunami simulations. Shuttle
Radar Topography Mission (SRTM) DEM was obtained through the USGS. This DEM was
generated during the two Endeavour missions in 2000. The DEM data has a cell size of 30
meters. With the DEM obtained, the next step was to import it into ArcGIS along with the
satellite Landsat-8 imagery. The satellite imagery was then used to generate the shoreline and
the simulation area. The next step was to create and define the areas submerged by the 2 m SLR
simulation.

1998 Population of Gwadar, Pakistan: 185,498
Population density: 393 people per km2
Total population at risk due to 2 m SLR: 1,757
(0.95% of total population)

Figure 48. Results of a 2 m SLR simulation for Gwadar, Pakistan
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Figure 48 displays the results of the 2 m SLR simulation. The simulation showed that
only 4.47% of the land in Gwadar was submerged due to SLR. The total population at risk is
1,757. This is based from the 1998 Pakistan Census [74]. Results from this simulation showed
that the land area submerged was only in the low-lying coastal undeveloped land. While this is
concerning for future development, the current infrastructure is not at that great of a risk. As the
port and city of Gwadar grow, development will be able to consider the effect of a 2 m SLR.

4.4 Simulation of Tsunami Hazard and Its Impacts
A 2 m tsunami WPH simulation was also performed for Gwadar. The method that was
performed is the same as Los Angeles and Miami and can be seen in Chapter 3. The primary
difference is that with Gwadar, SRTM DEM data was used instead of the 1-Arc Second DEM
used for Los Angeles and Miami. The 2 m tsunami WPH simulation methodology includes the
following main steps:
1. Create a shoreline and define the simulation area.
2. Create a shapefile of depth submerged by the 2 m tsunami WPH.
3. Overlay submerged land area from the 2 m tsunami WPH simulation on the metropolitan
boundary area map.
4. Evaluate the impact of a 2 m tsunami WPH on infrastructures and population.
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Figure 49. 2 m tsunami WPH simulation results for Gwadar, Pakistan
The results of the tsunami simulation are displayed in the Figure 49. The simulation
showed that 4.47 km2 would be submerged due to a tsunami wave. Key infrastructure assets that
would be affected include the port area that is currently being developed. The simulation shows
that there would be 1,762 people affected due to a 2 m tsunami wave [74]. This would not only
disrupt the development of Gwadar’s economy but would also hamper other countries as well.
This is because the port at Gwadar is considered the beginning of the Silk Road project being
developed by China. If a natural disaster, such as a tsunami, the trade network will become
burdened and will deal a massive blow to the economies of all the countries situated on the Silk
Road project. To better protect the port, the infrastructure and the people who live in the area, a
sea wall should be constructed to hamper any encroaching tsunamis.
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4.5 Statistical Significance Analysis of Topography Variability and Simulation Method on
Coastal Hazards
4.5.1 Sampling Design and Statistical Descriptive Summary for Coastal Hazard Simulations
A two-way ANOVA was formulated, to determine if there is statistically significant
difference between the means of submerged land by the simulation method (Factor 1) and by the
study site (Factor 2). Table 24 displays the sample design based on the 2 m tsunami WPH and 2
m SLR simulation methods for the three study sites. The grand total of simulation samples is six.

Table 24. Factorial for sample design
Factor 2

Miami, FL

Los Angeles, CA

Gwadar, Pakistan

Total

Tsunami WPH

Y1,1

Y1,2

Y1,3

3

Sea Level Rise

Y2,1

Y2,2

Y2,3

3

Total Samples

2

2

2

6

Factor 1

Table 25 and Table 26 show the statistical descriptive summaries for the simulation
method location and study site factor, which include the number of simulations performed, for
each factor the number of sites per simulation, the mean of the percent of submerged land, and
the standard deviation of the percent of submerged land. Table 25 shows the simulation methods
at two different levels (2 m tsunami WPH and 2 m SLR), while Table 26 shows the study sites at
three different levels (Los Angeles, Miami, and Gwadar). The dependent univariate response
variable, Y, is the percent of submerged land area.
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Table 25. Descriptive statistics for simulation methods

Factor 1

Factor 2

Submerged Land, Factor 1

Study

Y = Mean

Sites

(% land

(n)

submerged)

1. 2 m Tsunami WPH

3

146.75

32.20

2. 2 m Sea Level Rise

3

149.29

32.31

Simulation Methods and
Level

Standard
Deviation

Table 26. Descriptive statistics for study sites
Factor 2

Factor 1

Submerged Land, Factor 2

Simulation

Y = Mean

Method

(% land

(n)

submerged)

1. Miami, FL

2

57.08

0

2. Los Angeles, CA

2

1.49

0.19

3. Gwadar, Pakistan

2

0.95

0

Study Sites and level

Standard
Deviation

4.5.2 Univariate ANOVA Model
Equation 5 shows the two-way ANOVA model for this problem involving two factors.
The analysis considers both simulation methods (Factor 1) and study sites (Factor 2).
yij = µm + αi + βj + eij
where,
yij = percent of submerged land (dependent variable) due to Factor 1 and Factor 2
i = level of Factor 1, simulation method (i =1. 2 m tsunami WPH, 2. 2 m SLR)
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(5)

j = level of Factor 2, study site (j =1. Miami, FL, 2. Los Angeles, CA, 3. Gwadar,
Pakistan)
µm = grand mean (for all cities and simulation methods)
αi = effect of factor 1: simulation method (i = 1, 2)
βj = effect of factor 2: study site (j = 1, 2, 3)
eij = error, randomly normal distribution with mean equal to zero
4.5.3 Hypothesis Testing for Two-Way ANOVA


Factor 1: Hypothesis Testing for Simulation Methods

Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of the percent of submerged land due to a 2 m
tsunami WPH simulation and the mean of the percent of submerged land due to a 2 m
SLR simulation are equal.
H0: µ1 = µ2
Alternative Hypothesis, H1: In the population, the mean of the percent of submerged land due to
a 2 m tsunami WPH simulation and the mean of the percent of submerged land due to a
2 m SLR simulation are different.
H1: µ1 ≠ µ2
where,
µ1 = mean of submerged land due to a 2 m tsunami WPH simulation
µ2 = mean of submerged land due to a 2 m SLR simulation
Step 2: Select level of significance, α
An α of 0.05 for the probability of Type 1 error was selected as the level of significance
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for the ANOVA model of submerged land. For the simulation method, α/2 (0.025) is on each
side of the probability of Type 1 error associated with rejecting a null hypothesis when it is true.
This can be seen in Figure 50 for the F distribution used in ANOVA hypothesis testing.

Figure 50. The F distribution showing Type I error
Figure 50 shows the α/2 equal to 0.025 at each end of the F distribution. The α/2 (0.025)
is about two standard deviations away from the mean. This means that within the probability
distribution curve, 95% of all possibilities are contained within two standard deviations from the
population mean.
Step 3: Define criterion and decision rules for rejecting H 0
The ANOVA uses F test criteria and decision rule criteria for hypothesis testing. By
comparison of F critical and F test, the null hypothesis can be rejected or accepted. F

critical is

found through the distribution of F table for a given α value and degree of freedom. The F
test

is calculated as the ratio of mean squares (MS) between groups and MS within groups.

91

This is a standard output of a statistical program such as the Statistical Package for the
Social Sciences (SPSS) software [16].
The H0 is rejected if F test exceeds F critical (F test > F critical) or the SPSS result of
significance or probability (p) is less than the selected α /2 (0.025) or (p) < selected α/2.
F critical is defined in Equation 6.
F critical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025

(6)

where,
dfb = degree of freedom (df) between simulation method = K - 1
dfw = degree of freedom (df) within the sample = N – K
K = number of simulations = 2
N = number of samples = 6
dfb = 2 - 1 = 1
dfw = 6 - 2 = 4
Using the two sets of the degrees of freedoms, F critical was determined to be 7.71 for the
degree of freedoms of 1, 4 and an α of 0.05. However, the F critical needed is for 𝛼/2 = 0.025.
An additional F critical was needed. This was found looking at the higher level of significance
table for an α of 0.01. From this F distribution table, it was found that for an α of 0.01 and
degree of freedoms of 1, 4 is 21.20 [75]. With these two F critical values, linear interpolation was
performed to find the needed value for the α/2 of 0.025.
21.20 − 7.71
= 3.37
4
where:
F critical = F0.01, 1, 4 = 21.20
F critical = F0.05, 1, 4 = 7.71
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The linear interpolation value is then corrected to obtain the correct F critical.
F critical = 7.71 + (3.37 * 2.5)
F critical = 16.14 for α/2 of 0.025
The interpolated F critical value for an α/2 of 0.025 and degrees of freedom of 1, 4 is 16.14 [75].
Decision Rule: Reject the H 0 if F test exceeds F critical (F test > 16.14), or, in SPSS output, the
result of the calculated α/2 is less than or equal to the selected α/2 (calculated α/2 ≤
0.025)
Step 4: Compute the Test Statistic, F test
The test statistic or F test for the simulation method was calculated using the SPSS [16].
The first step in performing ANOVA was to select the Univariate test from the Analyze menu.
The menu path is shown in Figure 51.

Figure 51. Univariate analysis menu path
Once selected, the Univariate dialogue window appeared. This is shown in Figure 52.
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Figure 52. Univariate dialogue window
Within the Univariate dialogue window, the dependent variables and the fixed factors
were selected. For the ANOVA between simulation methods and study sites, the dependent
response variable was called Submerged Percent, and the two fixed factors were Simulation
Method and Study Site. The next step was to select the model. ANOVA requires that
interaction between two variables is tested; thus the interaction method was selected. The model
window with the two factors selected is shown in Figure 53.

Figure 53. Univariate model window
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After the model had been selected, a plot option was selected to see if there was any
interaction between the simulation method and the study site. The plot dialogue window is
shown in Figure 54.

Figure 54. Univariate plots window
With all the options selected, ANOVA was performed. Table 27 shows the SPSS output
for the two-way ANOVA.

Table 27. Two-way ANOVA test results from SPSS
Source

Type III Sum of
Squares (SS)

df

Mean
Square
(MS)

Corrected Model

4,160.768

3

1,386.923

Intercept

2,361.754

1

2,361.754

Simulation
Method

.024

1

.024

1.00

0.423

Study Site

4,160.744

2

2,080.372

86,442.05
8

0.001

Error
0.048
2
.024
Total
6,522.570
6
Corrected Total
4,160.817
5
a. R Squared = 1.000 (Adjusted R Squared = 1.000)
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F test
57,628.3
72
98,133.8
06

Significance
or Probability
(p)
0.001
0.001

Results
Significant
Significant
Not
Significant
Significant

Step 5: Interpret the results for simulation methods (SPSS results shows F test and Probability α
value)
Table 27 shows that the F test of the simulation method is 1.00, and the significance or
probability (p) value is 0.423. According to the decision rule of F test (1.00) < F critical (16.14) or
Sig (p) (0.423) > α/2 (0.025), the H0 was accepted. Therefore, in the population, there is no
statistically significant difference between the two simulation methods. In other words, the
difference in the mean of the percent of submerged land due to a 2 m tsunami WPH simulation
and the mean of the percent of submerged land due to a 2 m SLR simulation was statistically not
significant.
Factor 2: Hypothesis Testing for Study Sites
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the means of the percent of submerged land at the study
sites are equal.
H0: µ1 = µ2 = µ3
Alternative Hypothesis, H1: In the population, the means of the percent of submerged land at the
study sites are different.
H1: µ1  µ2  µ3
where,
µ1 = mean of the percent of submerged land in Miami, FL
µ2 = mean of the percent of submerged land in Los Angeles, CA
µ1 = mean of the percent of submerged land in Gwadar, Pakistan
Step 2: Selection of level of significance, α
An α of 0.05 was already selected to test the statistical significance of simulation

96

methods. Therefore the same is used for two-tailed tests where α/2 (0.025) remains the
same.
Step 3: Define criterion and decision rules for rejecting the H 0
The same criterion is used for rejecting the H0. If the F test exceeds F critical
(F test > F critical) or the SPSS significance or probability (p) is less than α/2, the H0 was
rejected. The F test is calculated as a ration of MS between groups and MS within groups,
which is a standard output of the SPSS software. F critical is defined in Equation 7.
F critical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025

(7)

where,
dfb = degree of freedom between study site = K– 1
dfw = degree of freedom within the sample = N – K
K = number of study sites = 3
N = number of samples = 6
dfb = 3 - 1 = 2
dfw = 6 - 3 = 3
Using the two sets of the degrees of freedom of 2, 3 and an α of 0.05, F critical was
determined to be 9.55. It was also determined that the F critical was 30.91 using the same degree
of freedoms and an α of 0.01. Linear interpolation was then used to find F critical for α/2 of 0.025
[75].
30.81 − 9.55
= 5.32
4
where;
F critical = F0.01, 2, 3 = 30.91
F critical = F0.05, 2, 3 = 9.55
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Once the linear interpolation was performed, it was important to back calculate using the
F critical for an α of 0.05. This is shown below.
F critical = 9.55 + (5.32 * 2.5)
F critical = 22.84
The interpolated F critical value for an α/2 of 0.025 and degree of freedoms of 1, 4 is 22.84.
Decision Rule: Reject the H 0 if F test exceeds F critical (F test > 22.84) or, in SPSS, results of the
calculated α/2 is less than or equal to the selected α/2 (calculated α/2 ≤ 0.025).
Step 4: Compute the Test Statistic, F test
The univariate ANOVA was run previously for hypothesis testing for simulation methods.
The process is the same, with the only difference being that instead of looking at the simulation
methods, the study site was analyzed. From Table 27, the F test for the study site was 86,442.058,
and the significance or probability (p) value is 0.001.
Step 5: Interpretation of the results for study sites (SPSS results show F test and Probability α
value)
With an F test of 86,442.058 and significance or probability (p) of 0.001, it could be
determined whether H0 could be rejected. Thus,
F test (86,442.058) > F critical (22.84) or p (0.001) < α/2 (0.025).
From the decision rule, the null hypothesis was rejected. This implies that in the
population there was the statistically significant difference between the study sites,
considering the mean of the percent submerged land.
From the univariate analysis, a plot was generated to show the relationship between
the simulation methods for each of the study sites.
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Figure 55. SPSS plot of the estimated marginal means for submerged percent for the study
sites
Figure 55 shows the interaction between the simulation method (2 m SLR and 2 m
tsunami) and the study sites because the two lines do not cross each other. The two plots
closely lie on each other, which indicate there is no statistically significant difference
between the two simulation methods. Figure 55 further shows that there is no interaction
between the study sites and simulation methods.
The means of submerged land for Miami is 38% larger than Los Angeles and 60%
larger than Gwadar. This is possibly due to the differences in the topography of Miami
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compared to the other two sites. The first site, Miami, has a gentle elevation rise inland.
The second site, Los Angeles, has a gentle rise for the first 10 to 20 meters inland and then
has a vast elevation change because of the location. The third site of Gwadar is mostly
located on a plateau beyond the coast, which extends throughout the peninsula of the study
sites.

100

CHAPTER V
SUMMARY, CONCLUSIONS AND RECOMMENDATIONS
5.1 Summary
Rural populations have been shown to be migrating into larger cities worldwide. This
migration requires that more complex infrastructure systems be created. Systems like these
include health, education, transportation, and protection services. With these systems being in
higher demand, a disaster could disrupt millions of people’s lives and the infrastructure that
serves them. However, while a natural disaster could strike at any moment, the rate of natural
disasters was determined to be decreasing through ANOVA .
Geospatial technologies and spaceborne remote sensing are widely available and are
continuously being upgraded. These technologies allow for the management of built and nonbuilt infrastructure, implementation of decision support systems for disaster management, and
infrastructure and communities to have better resilience protection. Geospatial planimetric
inventories were created for Gwadar, Pakistan, and Miami, Florida, to determine the built-up
infrastructure and open areas. City planimetric maps were created using Landsat-8 imagery, and
the areas of the built-up areas were calculated.
For Los Angeles, California, NLCD (2011) was used to determine the land use and land
cover for the surrounding metropolitan area. The metropolitan area was also found as a
shapefile, thanks to the metropolitan area chancery clerk’s office. This shapefile contained all
annexed areas of Los Angeles.

101

Two different simulations were performed in the three study areas that included a 2 m
SLR simulation and a 2 m tsunami simulation. These two simulations and the three study sites
allowed for ANOVA to be performed. ANOVA tested to see if there was any statistically
significant difference between the study sites and the simulation methods.
Extreme rainfall flood was also simulated for the Los Angeles area. This was performed
by obtaining hydrograph data for the San Gabriel River in Los Angeles. Once obtained, river
features were generated to create the scope of the four rivers. The software HEC-RAS was then
used to perform the extreme rainfall flood simulation.

5.2

Conclusions

Key findings are as follows:


Manual planimetrics is considered an accurate way to represent infrastructure features for
any given area. The planimetric method allows for the inspection of satellite imagery or
ground truth to determine the land use of that area.



LBANS is an auto-classification method to represent infrastructure features. LBANS
considers the color bands from satellite imagery. The bands are then sorted based on a
decision tree criteria. This is a faster method than the manual planimetrics. The main
drawback of LBANS is that with denser imagery and larger areas, processing and loading
time are extended.



The NLCD (2011) was used to classify the Los Angeles study area by built-up and nonbuilt features. An unsupervised classification was used to classify the area. This was by
far the quickest method to determine built-up and non-built features. One key drawback
to the NLCD is that it is only produced every five years. The NLCD available to the
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public is already 1 or 2 years old and will not include new area features that have been
produced since the NLCD for that period was calculated.


The study site of Miami, FL had 411.96 km2 submerged due to the 2 m SLR simulation
and 411.96 km2 submerged due to the 2 m tsunami simulation.



The study site of Los Angeles, CA had 33.76 km2 submerged due to the 2 m SLR
simulation and 26.14 km2 submerged due to the 2 m tsunami simulation.



The study site of Gwadar, Pakistan had 4.47 km2 submerged due to the 2 m SLR
simulation and 4.474 km2 submerged due to the 2 m tsunami simulation.



Through the ANOVA of statistical significance for the simulation method, it was found
that there was no difference between the mean of submerged land. This shows that a
model cannot be created to predict SLR and Tsunami risk areas.



Through the ANOVA of statistical significance for the study sites, it was found that there
was the statistically significant difference between the study sites. This can be seen in the
different topography in the three study sites.



Through comparison of extreme rainfall flood, 2 m SLR, and 2 m tsunami WPH
simulation for the Los Angeles area, it was found that extreme rainfall flood is more
disastrous to people and infrastructures compared to the other two simulations.



The land area submerged by water due to rainfall is 22 times larger compared to the 2 m
SLR simulation and 28 times larger compared to the 2 m tsunami WPH simulation for the
Los Angeles area.



Contrary to NOAA’s and the IPCC’s alarm about 2 m SLR impacts, rainfall flooding is
more damaging to infrastructure and people’s lives. It can happen any year compared to
the SLR speculation of the year of 2100 or beyond.
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SLR is speculated and will occur over several years, while tsunamis are almost
instantaneous, and are unpredictable. Tsunamis have far more force due to wave surges.



Tsunami’s pose more risk to people than SLR and rainfall flooding. This is due to the
reaction time tsunami’s have.



GeoMedia Professional, ERDAS IMAGINE 2013 (Intergraph Corporation), and ArcGIS
are user-friendly geospatial analysis and remote sensing applications that were used in
this research. The software GeoMedia Professional is more user-friendly geospatial
software compared to ArcGIS.



Both geospatial analysis software (GeoMedia Pro and ArcGIS) cannot process raster
imagery. The imagery was analyzed using EARDAS IMAGINE 2013 allows for more
detailed analysis to be performed.

5.3

Recommendations


Further simulations of SLR and tsunami will be required for other port cities. Future
possible study areas include Seattle, Washington; New Orleans, Louisiana; Tampa,
Florida; Charleston, South Carolina; Virginia Beach, Virginia; New York, New York.



The 2 m tsunami WPH and 1-D extreme rainfall flood simulations only accounted for the
ground elevation, provided by DEM. The two simulations should be adapted to include
the elevation of critical infrastructure.



The methodologies for SLR and tsunami simulations should be adopted into other
geospatial programs such as GeoMedia Professional.



Existing infrastructure should be hardened to improve resiliency to rainfall flood and
other natural disasters which frequently occur in the area. The hardening will not only
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strengthen the infrastructure but will improve the quality of service of the infrastructure.


In response to SLR and tsunamis, the existing sea walls in the three port cities should be
improved and lengthened to protect more infrastructure and people. Where possible, the
beaches of the port cities should be widened to allow for the creation of sand dunes. The
dunes will be able to help damper the effects of SLR and tsunamis if they occur.
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APPENDIX A
SELECTED SPATIAL MAPS

A1

Figure A1. Spatial map of Major Global Disasters, 1906-2000

A2

Figure A2. Spatial map of people displaced by natural disasters, 2013

A3

Figure A3. Spatial map of megacities of the world, 2015
A4

Figure A4. Projected megacities population, 2030

A5

Figure A5. Spatial map of worldwide active volcanoes, 2015
A6

.
Figure A6. Spatial map of the earth’s tectonic plate boundaries

A7

Figure A7. Infrastructure and Landuse map of Miami, Florida

A8

Figure A8. Spatial map of LBANS classification for Miami, Florida

A9

Figure A 9. Spatial map of sea level rise simulation overlay on boundary map,
Los Angeles and surrounding areas, California

A10

Figure A10. Spatial map of Sea Level Rise simulation overlay on Landsat-8 imagery, and
affected population map, Miami and surrounding areas, FL

A11

Figure A11. Spatial map of tsunami simulation overlay on Los Angeles metropolitan boundary
map
A12

Figure A12. Spatial map of tsunami simulation overlay on Landsat-8 imagery,
Miami and surrounding areas, FL
A13

Figure A13. Spatial map of cross sections and river paths overlay on DEM elevation map,
Los Angeles and surrounding areas, California
A14

Figure A14. Spatial map of floodplain simulation overlay on boundary map,
Los Angeles and surrounding areas, California
A15

Figure A15. Spatial map of planimetrics of Gwadar, Pakistan

A16

Figure A16. Spatial map of the composite LBANS classification for Gwadar, Pakistan

A17

Figure A16. Spatial map of tsunami simulation overlay on Landsat-8 imagery of Gwadar,
Pakistan
A18

Figure A18. Spatial map of Sea Level Rise simulation overlay on Landsat-8 imagery of Gwadar,
Pakistan
A19

Figure A19. Spatial map of tsunami simulation overlay on Landsat-8 imagery of Gwadar,
Pakistan
A20

APPENDIX B
STEP-BY-STEP PROCEDURE TO CREATE MANUAL PLANIMETRICS

B1

Step 1. Creation of Feature Classes
The first step in the creation of manuel planimetrics is to create the feature class. Feature Classes
can be any geometry type. This includes points, lines, areas, and text. Features Classes are
created by going to Warehouse > Feature Class Definition. The Feature Class Definition
dialogue box opens.

Figure B1. Feature Class Definition dialouge box
Click New to create a new feature class. The create a New – FeatureClass window opens.

Figure B2. New Feature Class window
B2

Within the New Feature Class dialouge window, the name of the feature class, the
Geometry type, and any attributes can be defined. Once created, the features can be drawn in.
Figure B3 displays the menu path for inserting features.

Figure B3. Insert Feature Menu Path
Once selected the Feature Insert Toolbar appears. The toolbar is shown in Figure B4.

Figuer B4. Feature Insert Toolbar
Once the features are created, manuel planimetrics can be performed. Figure B5 displays the
planimetrics for Miami, Flordia.

Figure B5. Planimetrics of Miami, Florida
B3

Step 2. Calculation of Area’s and Lengths from features
Once the features have been generated, the area or length can be determined. This
process is done through the use of functional attributes. Figure B6 displays the menu path for
function attributes.

Figure B6. Menu path for Functional Attributes
Once selected, the Functional Attributes dialogue box appears.

Figure B7. Functional Attributes Dialogue Box
Once in the dialogue box, select the desired feature and click new. The Functional
Attribute input dialogue box appears.

B4

Figure B8. Functional Attribute input dialogue box
The expression for determining the area is as follows: Area(Input.Geometry). The
expression for calculating length is Length(Input.Geometry). Once the appropriate expression is
entered, Click Add, and close the dialogue boxes.
Within the Functional Attributes Dialogue Box, the name should be changed for better record
keeping, as well as the option to generate a data window. The data window that will appears will
contain the Functional Attribute for Area or Length. Figure B9 displays a sample data window.

Figure B9. Sample data window showing area.
B5

APPENDIX C
STEP-BY-STEP PROCEDURE TO PERFORM CAIT METHODOLOGY FOR 2 M SLR
COMPUTER SIMULATION

C.1 Adding DEM Data and Landsat-8 Pansharpened Multispectral Imagery of Gwadar
C.2 Creating Elevation Ranges and Ocean Shapefile Feature Class
C.3 Creating Sea Level Rise Submerged Land
C.4 Creating Sea Level Rise Simulation Overlay on Landsat-8 Imagery and Affected Population
Maps

C1

C.1 Adding DEM Data and Landsat-8 Pansharpened Multispectral Imagery of Gwadar
The DEM data and Landsat-8 pansharpened multispectral imagery were used for a sea
level rise (SLR) simulation for Gwadar, Pakistan. The DEM data used for Gwadar were collected
from the USGS EarthExplorer.
Adding DEM Data into ArcMap
a) Click on the ArcMap icon on the computer desktop, the ArcMap - Getting Started dialog
box appears. Create a new map project. Figure C1 shows the Getting Started dialog box.

Figure C1. The ArcMap - Getting Started dialog box
b) Right click on Layers under Table of Contents, select Add Data, select the
SRTM_Gwadar.tif from the current folder - the SRTM_Gwadar.tif is the DEM tif file data
for Gwadar. Once selected click Add.
c) Choose File from the main menu, click Save As, the Save As dialog box appears.
d) From File name, type Gwadar_2m_SLR. Click Save. The 2 ft DEM contour data map was
saved as an ArcMap document.
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Adding the Landsat-8 Pansharpened Multispectral Imagery into ArcMap
e) Right click on Layers under the Table of Contents, select Add Data, and select
Gwadar_LS8_Pansharpened.img. Click Add, the Landsat-8 pansharpened multispectral
imagery of Gwadar appears on Data View window of ArcMap. This Landsat-8 pansharpened
multispectral imagery covers both ocean and land area of the study area.

Figure C2. The Landsat-8 pansharpened multispectral imagery of Gwadar on ArcMap
f) Double click on Gwadar_LS8_Pansharpened.img, a Layer Properties dialog box appears.
Click on Symbology, under Band, changed Layer_4 for Red, Layer_3 for Green and
Layer_2 for Blue. Click Apply, and then click OK. The Landsat-8 pansharpened
multispectral imagery of Gwadar is shown as natural colors on ArcMap. Figure C3 displays
the reclassification of the natural colors for the Landsat-8 pansharpened imagery.

C3

Figure C3. Selection of natural colors for the Landsat-8 pansharpened multispectral imagery
g) In the Table Of Contents, left click on 2SRTM_Gwadar.tif and press the mouse then drag
the 2SRTM_Gwadar.tif to the top on the Table Of Contents.
C.2 Creating Elevation Ranges and Ocean Shapefile Feature Class
Making Desired Intervals of Elevation using the Reclassify Function
a) From main menu of the ArcMap, select Geoprocessing, select ArcToolbox. The ArcToolbox
dialog box appears.

C4

Figure C4. ArcToolbox dialog box
b) From ArcToolbox dialog box, select 3D Analysis Tools > Raster Reclass > Reclassify. The
Reclassify dialog box appears. Figure C5 displays the Reclass fuction menu path.

Figure C5. Reclassify function menu path
c) Under Input raster, select 2SRTM_Gwadar.tif . Under Reclass field select Value. Under the
Reclassification space, the elevation values are reclassified into 9 separate intervals in the
Old Values column. Each interval was assigned with an integer value from 1 to 9 in the New
values column. Figure C6 displays the Reclassify function dialog box
C5

Figure C6. Reclassify function dialog box
d) Click Classify, the Classification dialog box appears and is shown in Figure C7.

Figure C7. Classification dialog box with 9 classes
e) In the Classes box, select 116. In the Break Values column, type 0, 1, 2, 4, 6, 9, 12, 15, 20,
30, 40, 50, 70, 100, 200, and 366 from top to the bottom. These values represent the
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elevation ranges that the DEM will display. Figure C8 displays the 16 classes used for
Gwadar.

Figure C8. Classification dialog box with 16 classes
f) Click OK. The DEM has been reclassified with 16 ranges. Note that the number of ranges of
elevation depends on the minimum and maximum values of elevation.
g) Under Output raster, type Range as output raster file. Tick the check box of Change missing
values to NoData (optional). Click OK. The 16 ranges of elevation appear. The 16 ranges for
Gwadar are displayed in Figure C9.

C7

Figure C9. The 16 elevation ranges for Gwadar
h) From the ArcToolbox dialog box, select Conversion Tools > From Raster > Raster to
Polygon. Figure C10 displays the menu path, while Figure C11 displays the Raster to
Polygon dialog box.

Figure C10. Menu path for Raster to Polygon Function

C8

Figure C11. Raster to Polygon dialog box
i) Under Input raster, select Range. Under Field (optional), select VALUE. Under Output
polygon features, type Ele_Polygon as the name of the elevation ranges polygon shapefile.
j) Click OK, the Ele_Polygon shapefile feature class appears on the Table of Contents as well
as Data View. The Elevation Polygon is displayed in Figure C12.

Figure C12. Elevation polygon map of Gwadar

C9

k) The Ele_Polygon shapefile feature class includes both land and some parts of ocean areas.
In order to calculate area of submerged land by 2 m SLR from the Ele_polygon shapefile
feature class, the ocean areas are separated from the Ele_polygon shapefile.
Creating Ocean Shapefile Feature Class
l) Open Catalog window by click on Catalog icon or select Catalog from Windows menu. The
Catalog window appears as shown in Figure C13.

Figure C13. Catalog window for creating a new shapefile feature class
m) Right click on Ocean folder, select New > Shapefile. A Create New Shapefile dialog box
appears.
n) Type Ocean as the name of the shapefile feature class, selects Polygon as the Feature Type,
and select WGS_1984_UTM_zone_41N as the coordinate system of Ocean shapefile feature
class. Click OK. The Ocean shapefile is created.
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o) Double click on the symbol for the Ocean shapefile feature class in the Table of Contents.
The Symbol Selector dialog box of the Ocean feature class appears.

Figure C15 Symbol Selector dialog box for ocean feature class
p) Click Edit Symbol, a Symbol Property Editor dialog box appears. From Type, select Line
Fill Symbol. Under Line Fill, type 135 for Angle, keep 0 for Offset, and type 2 for
Separation. Select blue color with RGB (0, 197, 255). Click OK. The same style is then
applied to the outline of the ocean shapefile.
q) Double click Ele_Polygon layer in the Table of Contents, the Layer Properties of the
Ele_Polygon shapefile feature class appears. Click on Display and enter 50 in the
Transparent box. Click OK. The Ele_Polygon shapefile feature class is displayed on top of
the Landsat-8 pansharpened multispectral imagery with 50% translucency.
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r) From Editor toolbar, select Start Editing; select Ele_Polygon in the Start Editing dialog
box. Click OK. Then click on ocean areas on the Ele_Polygon map on Data View, the
elevation polygons in ocean areas were selected.
s) Click on Cut Polygons Tool symbol on the Editor toolbar, then draw a close polygon
surrounding ocean areas. Right click and select Finish Sketch. The Landsat-8 imagery and
Ocean shapefile is shown in Figure C16.

Figure C16. Gwadar displayed with elevation and ocean shapefile
C.3 Creating 2 m Sea Level Rise Submerged Land
Figure C17 shows the 16 ranges of elevation for Gwadar. For 2 m SLR simulations, all
polygons with an elevation of 2 m and below are reclassified as submerged. The second range
(new values = 2) is from 0 to 1 meter elevation. The third range (new values = 3) is from 1 to 2
meter elevation.

C12

Creating a 2 m Sea Level Rise Submerged Land Shapefile Feature Class
a) Right click on Ele_Polygon layer in the Table Of Contents, select Open Attribute Table, the
attribute table of the Ele_Polygon shapefile feature class appears.

Figure C18. The attribute table of the Ele_Polygon shapefile feature class
b) Click on icon on the left corner of the attribute table. Choose Select By Attributes. The
Select By Attributes dialog box appears. Select GRIDCODE = 2 and GRIDCODE = 3.
c) Click Apply, the polygons, which GRIDCODE = 2 and GRIDCODE = 3, are selected. The
selection of GRIDCODE is shown in Figure C19.
d) Right click on Ele_Polygon layer in the Table Of Contents. Select Data > Export Data. The
Export Data dialog box appears. The menu path is displayed in Figure C20. Choose
Selected features in Export. Under Output feature class, type 2m_SLR_Submerged. Click
OK. A message “Do you want to add the exported data to the map as a layer?” Click Yes,
the exported 2m_SLR_Submerged feature class is added as a layer in the Table Of Contents
window and displayed on the Data View.
C13

Figure C19. Classifying 2 m SLR submerged land shapefile feature class

Figure C20. Option for exporting data in map as a new layer
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Calculating Area of the Submerged Land
e) Right click on the 2m_SLR_Submerged shapefile feature class in the Table Of Contents.
Choose Open Attribute Table. The attribute table of the 2m_SLR_Submerged shapefile
feature class appears.
f) Click on icon on the left corner of the attribute table. Choose Add Field. An Add Field
dialog box appears. Enter Area_Km2 as the name of the field. Select Double as type of field.
Click OK. The Area_Km2 field is added into the attribute table of the 2m_SLR_Submerged
shapefile feature class. Figure C21 displays the new attribute field that was created.

Figure C21. Created Area_km2 field for the 2m_SLR_Submerged shapefile feature class
g) Right click on Area_Km2 field, select Calculate Geometry. A Calculate Geometry dialog
box appears as shown in Figure C23. Select Square Kilometers [sq km] as the units of area
calculation. Click OK, the area of the submerged features are calculated in square kilometers.
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Figure C23. Calculate geometry function selection
h) Right click on Area_Km2 field; select Statistics. A Statistics of 2m_SLR_Submerged dialog
box appears as shown in Figure C24.

Figure C24. Statistics of depth submerged features from 0 to 1 meter
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C.4 Creating Sea Level Rise Simulation Overlay on Landsat-8 Imagery and Affected Population
Maps
a) Right click on the Layers in Table of Contents, select Add Data, select City shapefile feature
class that contain cities in the study area.
b) Double click on symbol of the City layer, the Symbol Selector dialog box appears. Select 8
as size of the symbol and red color with RGB (255, 0, 0). Click OK. The Symbol Selector
dialog box is shown in Figure C25.

Figure C25. Symbol Selector dialog Box
c) Double click on symbol of 2m_SLR_Submerged shapefile feature class in the Table of
Contents. The Symbol Selector of the 2m_SLR_Submerged feature class appears
d) Click on Edit Symbol, a Symbol Property Editor dialog box appears From Type, select Line
Fill Symbol. Under Line Fill, type 135 for Angle, keep 0 for Offset, and type 2 for
C17

Separation. Select blue color with RGB (0, 197, 255). Click OK. Click on Outline, a
Symbol Selector dialog box appears. Select the same blue color (0, 197, 255) the same color
is selected for Line Fill. Type 1 as the width of the outline. Click OK to close the Symbol
Selector dialog box.
e) From main menu, select View > Layout View. The layout view window allows creating a
spatial map by adding legend and other map properties.
f) Double click on 2m_SLR_Submerged layer in the Table of Contents, the Layer Properties
dialog box appears. Under General, type 2.0 m SLR Submerged Land in the Layer Name
box. Click OK.
g) Right click on Layers in the Table of Contents, select Properties, the Data Frame Properties
dialog box appears. Click on Frame, select None under Border. Click OK. The frame of the
map disappears.
h) From main menu, select Insert, the list of tools such as Text, Legend, North Arrow, and
Scale Bar that allows adding title, texts, legend, north arrow, and scale bar for the map.
i) From main menu of the ArcGIS, select File > Export Map, the Export Map dialog box
appears. Type Gwadar_2m_Sea_Level_Rise as the file name and select JPEG as the
extension of the exported map. Click Save, the spatial map of 2 m SLR is exported to a
JPEG file. Figure C30 displays the exported spatial map of 2 m SLR for Gwadar, Pakistan
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Figure C30. Exported spatial map of 2 m SLR
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